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POWERTEACHER 
 

Logging in 
 
URL:   http://Yourseveraddress/teachers 

 

 
 
Enter your username in the top box and password in the lower box then click on the 
Enter button or your Enter key on your keyboard and a screen similar to the one below 

will appear: 
 

 

 
 
Notice only the classes you teach are listed.  

http://yourseveraddress/teachers
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Left Navigation Icons 
 

PowerTeacher Pro 
 

The PowerTeacher Pro link will take you to the PowerTeacher Pro 
Gradebook. 

 

 
 

Start Page  
 

The Start Page link will take you back to the first page after you 

log in. 
 

 
 

 
Daily Bulletin  

 
The Daily Bulletin link allows your administrators to communicate with teachers and 

parents. 
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Schedule  
 

The Schedule link displays the Teacher’s schedule Matrix. 

 

 
 

Staff Directory 
 

The Staff Directory link allows you to view information about your colleagues. 
Information must exist in PowerSchool before any information can be viewed here. 

 
 
Meals  

 
The Meals link allows you to view your personal lunch balance if your school uses 

 PowerLunch. 

 
 

Personalize  

 
The Personalize link allows you to change your password and set up the page most 

useful to you after you log on.  
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Reports  

The Reports link allow you to print reports that have been made available to you by your 
school’s PowerSchool administrator 

 
 

Recommendations 

 
The Recommendations link will allow schools that use Teacher Recommendations to 

submit/view recommendations for a group of students or a single student. 

 
 

Old Gradebook  
 

The link for the Old Gradebook is used if a teacher still has one or  
more sections  associated to Powerteacher Gradebook.  Click on the  

Arrow to select the Installer Method or the Old Java based launch  
method. 

 
 

 

District Code  
 

If teachers are still using PowerTeacher Gradebook, then the 4-character code that 
teachers would need to log into the PowerTeacher Mobile App for iPad will appear.  This 

app is only used by teacher that are still using PowerTeacher Gradebook.  There is not a 
Mobile App for PowerTeacher Pro as this gradebook is available in full form on all 

platforms/devices. 
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Additional Start Page Icons: 
 
Help  

 
The Button at the top right part of your screen next to the Logout Button can answer 

many questions. Please be sure you are located on the page you wish to receive 
information about. Then click on the ? symbol for more information. 

 

 

 
PowerSchool Icon 
 

The PowerSchool icon in the upper left corner is the  
Home key for PowerTeacher.  Click on the Icon to return 

to the Start Page in PowerTeacher. 

 

Course Icons 
 
Seating Chart Setup 
 

PowerSchool now has the ability for Teachers to create seating charts.  Seating Charts 
can then be used to take attendance.  As a result, the Seating Chart Design option is 

located within the Attendance pages. 
 

Within the Seating Chart, the teacher has the ability to create arrangements using rows 
or tables, the number of which is set by the teacher. 

 
To Create a Seating Chart the teacher would first click on the Attendance Chair from the 

Start Page and then go to Seating Chart Design. 
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• To add a row, click on the Row Button.   

Select the desired number of rows and 
Columns and then click Add. 

 
  

 
 

 
     This would return a blank chart that looks like 

the one to    the picture on the left 
 

    
     

 
 

 

 
 

 
• To add Tables, click on Table button.   

Select the desired number of tables, the 
number of chairs at each table and then  

number of tables to appear in each row. 
 

 
 

This would return a blank chart that looks like 
the one to the left. 
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• To add a single Chair, click on Chair button.  This will add one additional chair to 
your chart. 

 
• You can also add additional items to your chart such as a Teacher’s desk, White 

Board, Door and Class label.  To add any of these items you would simply click on 

the appropriate button at the top of the screen.  These items allow you to orient 
your room correctly.   

 
• To remove an item from the Chart simply highlight (click on) that item and then 

click Remove. 
 

• You can “UNDO” your last movement by clicking the Undo button.   
 

• The Scale slide on the right side of the screen will allow you to zoom in/out of your 
seating Chart. 

 
• You can also move any item on the chart by clicking on and dragging the item 

where you want it to sit. 
 

 

 
 

 
 

 
 

 
 

 
 

 
 

 
• Once you have finished the layout of your seating chart you can save the layout by 

clicking Edit.  When you do this a new window will appear.  Give this layout and 

Name and Description and then click “Save as New”. 
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• After your layout has been saved, you can populate it with students by clicking on 
the Populate button.  This new window will ask how you want your students 

arranged on the page. 
 

 
 

 

 
 

 
 

 
• Choose how you want your students Sorted, whether you want them ordered A-Z 

or Z-A, whether you want the First Name or Last Name Displayed, and finally 
when populating the chart do you want PowerSchool to start adding student from 

the Top Left or Right or the Bottom Left or Right.  Once you have made all  
your selections click Add. 

 
• Finally, after you have finished creating and populating your seating chart be sure 

to hit “Save” to capture any changes. 

 
Attendance 
 

Teachers have multiple options for how they would like to take attendance.  They can 
take attendance for just a Single Day, for Multiple Days or using the Seating Chart.   

 
Once any of the attendance options is selected, the teacher gains access to the 

additional options of entering attendance for a Single Day (date of their choosing or 
current date depending on School Setup), for Multiple Dates (if enabled) or through the 

Seating Chart.  Additionally, in the Single Day view, Teachers can see any Alerts that 
have been created students.  To view the Alert information simply click on the Icon to 

open the Alert window.  
 

 
 

 

 
 

 
 

 
Single Day Attendance 

 
• From the Start Page, click on the Chair Icon.  



POWERTEACHER PRO USER GUIDE          
 

PREPARED BY:                                                      15         

 
• First, select the attendance code from the drop down.   

• Next click the Date for which you wish to enter attendance. 
• If there are multiple sections of this course you can click on Show Multiple 

Sections. It will then show you a combine roster of students. Click Show Single 
Sections to revert to just the one section. 

• Click into the blank field to the can either select the correct Attendance code from 
the drop-down menu at the top then click in the box to the right of the student’s 

name.  Whichever attendance code you initially selected will appear at the top of a 

new drop down.  Simply move to the next student or if you need to select a 
different code do so from this drop down. 

 
 

 
 Once an attendance code has been  

 entered for a student you will see a  
 gray balloon icon appears to the right  

 of the code.  By clicking on this icon  
 a teacher can now enter Attendance  

 Comments. 
 

 
 

 

 
 

 
 

 
• Once all information for this class has been entered click submit to save the 

attendance information.  Note that students are assumed present so you do NOT 
actually need to select the present code. 

• After you have clicked SUBMIT a green dot will appear that confirms attendance 
has been recorded for this class. 

 
  

 
Multi Day Attendance –  

 

• First, select the attendance code from the drop down.   
• Next Select the Date Range for which you wish to enter attendance.  Note that 

PowerSchool will default to the current Month’s Attendance 
• If there are multiple sections of this course you can click on Show Multiple 

Sections. It will then show you a combine roster of students. Click Show Single 
Sections to revert to just the one section. 

• Click into the cell for the blank field for the student/date you wish to enter 
attendance for.  Whichever attendance code you initially selected will appear at 
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the top of a new drop down.  Simply move to the next student/date to enter the 
next code.  Note that you do not actually have to select the attendance code first, 

you can click into the date cell and select the code directly from the list of 
available codes. 

 
 

 
 

 

 
 

 
 

 
• Once an attendance code has been entered for a student you will see a gray 

balloon icon appear to the right of the code.  By clicking on this icon, a teacher can 
now enter Attendance Comments. 

 
 

 
 

 
 

 

 
• Once all information for this class has been entered click submit to save the 

attendance information.  Note that students are assumed present so you do NOT 
actually need to select the present code. 

• After you have clicked SUBMIT a green dot will appear that confirms attendance 
has been recorded for this class. 

 
 

 
 Attendance through the Seating Chart 

 
Please note that Attendance taken through the Seating Chart may be taken for a Single 

Date and Single Section. 
 

• First, select the attendance code from the drop down.   

• Next click the Date for which you wish to enter attendance. 
• Click into the Drop-Down box for the student for whom you wish to register 

attendance.  Select the Attendance code.  Move to the next student and repeat. 
• Once all attendance has been entered click submit. 
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Knife and Fork  
 

Used for submitting lunch counts, if PowerLunch is being used. 
 

 
 
Printer 

 
Used to print any reports that have been made available to you. 

 

The Backpack Icon 
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Backpack Icon 
 

The Backpack Icon allows the Teacher to view information specific to each student.  
Many of these pages are the same as Student screens available on the Admin side of 

PowerSchool. 
 

Once you click on the Backpack Icon             it will take you to the Student Information 
screen. 

 

Click on the name of the student to open the Screen Selection Page. 

 

 
 
Click on the LAST NAME of a student for menu items as a drop down to appear on the 

right. After choosing a menu item, click on the subsequent FIRST NAMES to stay on 
the current screen! 

 
Click on a Class Name to take you to another class! 

 
 

Backpack Menu Items - (Drop-Down Selections) 
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1.  Cumulative Grade Information – This is the same as the Cumulative Info  
         Screen on the Admin side and Shows  

2.  Demographics – Shows basic demographics information as entered via the   
     Admin Portal. 

3.  Final Grade Entry – This is only available if turned on and is used for Final  
Standards Grade entry through PowerTeacher.  (Standards Grades entered 

through the PowerTeacher Pro will not appear here.  Likewise, Standards grades 
entered her will not appear in PowerTeacher Pro.) 

4.  Graduation Plan Progress – This is the same screen as the Admin side.  It will  

only appear if a Graduation Plan has been setup for the school. 
5.  Meeting Attendance – Shows Period attendance for the student 

6.  Net Access Summary - (Date and duration of when a parent has accessed their  
child’s information) 

7.  Print a Report – If reports have been opened to Teachers then they will appear  
here.  This option only prints reports for the selected student. 

8.  Quick Lookup – Same Screen as the Admin side.   This is an overview for each  
student and shows the students class schedule and attendance.  Clicking on Term 

Grades will open the Score display screen so you can see assignments/scores 
earned in each class. 

9.  Recommendation - Teachers use this screen to make course recommendations  
for future schedule requests (High Schools). 

10. Schedule – This screen shows the selected student’s current class schedule. 
11. Student Photo – This screen will display the selected student’s photo if one  

 has been uploaded to PowerSchool. 

12. Submit Log Entry – Allows teachers to submit Log Entries (Discipline, Medical,  
 etc.) if Log Entries have been configured for the school.  Note teacher cannot see    

 Log Entries once submitted. 
13. Teacher Comments – This screen allows teachers to see any comments Final  

Grade Comments that have been entered for a student.  Comments for different     
 terms can be viewed by selecting the appropriate Term from the top of the   

 screen. 
14. Term Grades – This screen allows the teacher to see Final Course grades for the  

   current year. 
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Part 2 
 

PowerTeacher Pro 
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POWERTEACHER PRO 
 
Welcome to the new PowerTeacher Pro Gradebook for PowerSchool Version 10.1+.  With 

PowerTeacher Pro, no longer will users have to worry about “launching” the gradebook 
as PTP is now built into the web pages of PowerTeacher.  Being built on the HTML5 

platform, PTP is now fully functional on both Window and Mac, Android and iPhone, iPad, 
Windows and Android tablets as well as on Chromebooks.  Teachers will no longer need 

a separate mobile app to access the gradebooks as the PowerTeacher Pro is fully 

functional on all mobile devices. 
 

Accessing PTP 
 

After logging into PowerTeacher click on one of the links for PowerTeacher Pro.  
 

 
 
 

This will bring you to the PowerTeacher Pro Assignments screen for the selected class. 
 

(Clicking on the PowerTeacher Pro link under Navigation will open PTP to the 
Assignments screen for the first class in your class list in PTP. Clicking on the PTP link 

for a specific class will bring you to the Assignments screen for the selected class.) 
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Gradebook Elements 
 

 
 
Top Bar 

 
1.   Class List – This is the list of classes. Click on the lists to select the class or  

  group of classes in which you want to work. 
2.   Create – Use this link to Create New Assignments and or Categories. 

3.   Help – Click on the link to access the PowerTeacher Pro Help window.  Options   

  available include, Online Help, Tips and Tricks, Getting Started Outline, What’s  
  New and Video tutorials. 

4.   Sign Out – Click on the Teacher Name to access the link to Sign Out of   
  PowerTeacher Pro as well as select the Display option for the gradebook.  

5.   Options Gear– Click to access the ability to hide/show various elements at the  
  top of the screen as well as access the Copy Assignment Function.  Options  

  included will depend on the screen you have selected. 
6.   Term – Click to select term in which you wish to work. The current term will  

  display based on the current date and the Default Term setup value set from the  
  Admin side of PS. 

 
Charms Bar 

 
7.   Grading – Click this link to access: Assignment List, Scoresheet, Categories  

  Setup, Traditional and Standards Final Grades as well as Comment Verification. 

8.   Students – Use to access information for individual students.  Available  
  information includes: Assignments, Standards Progress, Comments,    

  Demographics and Quick Lookup. 
9.   Progress – Use this link to View Graphically, how students are doing across   

  both Traditional and Standards Grades. 
10. Reports – Use this screen to access built in reports.  Currently, available reports  

  include:  Individual Student Report, Multi-Function Assignment Report,   
  Scoresheet and Student Roster. 

11. Settings – Use this link to access display option for the gradebook.  Available   
  options currently include:  Display Settings, Class Description, Traditional Grade  

  Calculation, Standards Grade Calculation and Recalculate Final Grades. 
12. Apps – Use this link to return to the PowerTeacher Portal. 

13. Assignment List – Displays a list of all assignments for the selected class(is). 
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1. Switching Classes 
 

In PTP you have the option of working with an individual class or working with a pre-
determined group of classes.  Groups are defined one of four ways.  Course number, 

Period/Day, School and All Classes. 
 

Class Groups allow the teacher to create categories and/or assignments that apply to all 
classes within the selected group.  (Currently, teachers cannot create their own groups.)  

 

To select a class and/or group: 
 

1. Click on the drop-down list at the top of the Start Page. 
2. If the teacher wishes to work with a single class click, on the Classes tab. If the 

teacher wishes to work with a group of classes, click on the Group Tab. 
3. Select the Class or Group in which you wish to work. 

a. Clicking on the Name of the Class will take the teacher to the Assignment 
List for the selected class. 

b. Clicking on the blue Grid Icon, to the right of the class name, will take the 
teacher to the Score Sheet View for the selected class. 

c. Clicking on the Graph Icon, to the right of the class name, will take the user 
to the Standards Progress screen for the selected class. 
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Groups: 
 

Groups are created automatically in PowerSchool.  Currently, classes will be grouped 
using the following criteria: 

 
 

1. Course number - Classes that have the same course number will   
automatically be grouped together.   

2. Period/Day combination - Classes that meet the same period and day will be  

grouped together.   
3. School - If a teacher teaches in multiple schools, and the accounts are linked  

through a Unified Teacher Record, then the teacher will ALL classes from ALL 
schools within the available classes.  Additionally, the teacher will see a 

separate class group for each of his/her schools.   
4. All Classes - This is a group of ALL classes within the teacher’s gradebook.   

Class Groups allow the teacher to create categories and/or assignments that 
apply to all classes within the selected group.  (Currently, teachers cannot 

create their own groups.)  
 

To see which classes are included within a specific group, click on the down arrow to the 
left of the group name.  Click on the group itself to work with that group of classes. 
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2. Create  

Creating Categories 

 
PowerTeacher Pro allows for Administrators to push out some District/School level 

settings to Teacher’s Gradebooks.  One of those items is Categories. Teachers can then 
create additional categories directly in PTP.  With PowerTeacher Pro you can create 

categories that are available to all sections or you can create categories that are 
available only to selected classes. 

 
Create a new category: 

 
1.  Click on Create. 

 
2.  Select Category from the drop-down list. 

 

On the next screen: 
 

3. Click on the Category tab. 
 

4. Select the Class(es) for which 
    you wish to associate this category. 

 
5. Give the category a Name. 

 
6. Select a Color for the category. 

 
7. Check to Make the Category Active. 

   
8. Give the category a Description. 
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Set the Assignment Defaults for the category (click on the tab).  Assignment Defaults 
allow the teacher to set the most common attributes for assignments within a given 

category.  (Assignment defaults, can be overwritten, at the assignment level.) 
 

9. Assign a Score Type 
 

a. Point (point value other than 100)  
b. Percent (assignment based on 100) 

c. Grade Scale (use the “Letter” grade 

from the associated Grade Scale) 
d. Collected Only (does not count 

towards final grade only used to  
mark assignment as collected)  

 
10. Assign Weight (if any) 

 
11. Assign Extra Points (if any) 

 
12. Select the Publish Assignment Options 

 
a. Immediately – The Assignment 

appears as soon as the assignment  
is saved. 

b. On a Specific Date – Enter the  

date you want the Assignment to appear. 
c. Days Before Date Due – Enter the number of days Before the due date 

that You want the assignment to appear. 
d. On Due Date – Assignment will appear on the Due date as entered on the  

assignment. 
e. Never – The assignment will not appear on any of the Public Portals.  Please 

be aware that the assignment score will still average into the Final Grade 
course grade even though the assignment is not visible. 

 
13. Check the box to Publish Scores.  

 
Click Save to save the assignment. 
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View All Categories 

 

1.  Click on the View Tab to see a list of all categories  
 

• This is a view only display which shows the color, Name, Classes Using the 
category and the Status (If active, a check will appear).   Categories that 

have the school Icon to the right have been pushed out by the 
School/District.  Editing Categories will be discussed in a later section. 

 

 
 

 

Creating Assignments 
 

PowerTeacher Pro offers a flexible way to create Assignments.  Unlike PowerTeacher 

Gradebook, Teachers can create assignments for multiple classes at once, they can link 
assignment to a specific group of students as well as associate Standards to the 

assignments. 
 

 

Create an Assignment  

 
1.  Click on Create 

2.  Select Assignment from the drop-down list. 
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On the next screen: 
 

3.  Click on the Assignments tab. 
 

4.  Click on Select Classes. 
(By default, the current/selected class will 

         be checked.  To add additional classes 
         check the box(es) for those classes.) 

 

5.  Enter a unique Assignment Name. 
 

6.  Select the Category to which you  
 wish to associate the assignment.  

 (Note:  The Values for Score Type,  

 Extra points, Score Entry Points, 
 Counts in Final Grade and Publish Options  

 will pull from the Category setup.   
 If different values are needed for a specific  
 Assignment, proceed with the steps below.) 

 

7.  Select the Score Type for the Assignment. Options Include: 
• Points 

• Percent 
• Letter Grade 

• Collected Only 
 

8.  If Extra Credit will be associated to the assignment click on Extra Points and   
 then enter the appropriate number of extra credit points. 

 
9.  If the assignment will have a weight value other than 1, click on Weight and then   

 enter the correct weight for the assignment. 

 
10. Enter the appropriate Score Entry Point value for the assignment. 

 
11. Check the box if the assignment is to Count in Final Grade.  

 
12. If desired enter a Description of the assignment. 

 
13. Click Save to create the assignment and keep the Assignment window open. 

(Helpful if you wish to duplicate the assignment) or Save and Close to close the 
Assignment window.  Regardless of which option is chosen a Message window will 

appear indicating that the assignment has been saved and giving the user the 
option to Score the assignment.  Selecting this option will automatically take the 

user to the Score Entry screen for the newly created assignment. 
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Create an Assignment for Select Students 

 

If you wish to create an assignment for just a select group of students, you will follow 
the directions as listed above to create the initial assignment.  Once the assignment 

information has been entered you will then do the following: 
 

 
1. Click on the Students tab 

 
2. Click on Add/Remove Students 

 

3. Check/uncheck the box to the  
right of *student’s names. 

 
• Check = included 

• Unchecked = excluded 
 

*(If the assignment has been  
linked to multiple sections all  

students will appear in this one  
list.) 

 
4. Click Save to save the  

assignment. 
 

Link Standards to an Assignment  

 

If you wish to link Standards to an individual assignment, you will follow the directions 
as listed above to create the initial assignment.  Once the assignment information has 

been entered you will then do the following: 

 
1. Click on the Standards tab. 

 
2. Click on Show Selected Standards 

 
3. Check / Uncheck the option to:  

Auto-Calculate Assignment  
Standard Scores.  Note the default 

Setting for this value is set by  
Going to Settings > Display Settings > Auto- Calculate Assignment 

Standard Scores – Initial State. However, this does allow you to choose on an 
Assignment by Assignment basis if you want to use assignment scores to set the 

Standards Scores. 
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4. Click Add/Edit Standards. 
 

5. Select the Standard(s) you wish  
to attach to the assignment by  

clicking on the box to the right. 
 

 
 

 

 

Select Publish Options for an Assignment  

 
PowerTeacher Pro gives you the option of if/when you wish to publish an assignment to 

the Public Portals.  These include the Quick Lookup screen in PowerSchool Admin and 
PowerTeacher as well as the Parent/Student Portals. If left at the default, the 

assignment will be visible to all Public Portals (as enabled from the Admin Side of 
PowerSchool) as soon as the assignment is saved.  Teachers do have other options as 

well.  To set the Publish option for an assignment you will follow the directions as listed 
above to create the initial assignment.  Once the assignment information has been 

entered you will then do the following: 
 

1. Click on the Publish tab. 
 

2. Select the appropriate Publish 
option. 

• Immediately – The 

assignment appears when 
the assignment is saved. 

• On a Specific Date – Appears 
on the date entered here. 

• Days Before Date Due – 
Enter the number of days, 

before the due date, that 
you want the assignment 

To appear. 
• On Due Date – Assignment 

will appear on the assignment  
due date. 

a. Never – The assignment will not appear on any Public Portal.  Be aware that 
the assignment score will still average into the Final course grade even 

though the assignment is not visible. 

 
3. Check the box to Publish Scores. (If you do not publish scores, the Include in 

Final Grade option must be unchecked for the assignment.) 
 

4. Click Save or Save and Close to save the assignment. 
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Duplicate an Assignment 
 

In addition to linking assignment to multiple classes upon creation, Teachers also have 
the option to “Duplicate” the setup from one Assignment to another.  This is not the 

same as the copy function currently in PowerTeacher Gradebook, but rather the ability 
to take an existing assignment and duplicate all settings, to a second assignment, with a 

new name.  This can be done when initially creating assignments, or teachers can select 
an assignment that already exists and duplicate.  Note all settings from the original 

assignment; Students, Standards, Publish, will be applied to the new assignment unless 

changed during the creation process.  The assignment name will be duplicated and an 
extension of _1 will be added. Once the original assignment information has been 

created you will then do the following: 
 

If duplicating after creating the assignment. 
 

1. Click Duplicate bottom right corner. 
 

2. Give the assignment a new name if  
desired.  Otherwise the name will be 

duplicated and an extension of _1 will 
be added. 

 
3. Select how you want to assign the date 

• Per Class – If the assignment is  

associated to more than one class, 
you can assign a different date for 

each class. 
• Single Date – Assigns the same 

date for all classes. 
 

4. Enter the actual Date Due. 
 

5. Give the assignment a Description. 
 

6. Click Save or Save and Close to save 
    the new assignment. 

 
7. Click on the X in the upper right corner 

to close the Assignment Window.  
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3. Help   
 

The Help link allows access to several online Help Features.  These include: 
 

• PowerTeacher Pro Help 
 

• Tips and Tricks 
 

• Getting Started Outline 

 
• What’s New 

 
• Video tutorials 

 

Help 

 

Like the Help feature in PowerSchool, clicking on 
the Help link will open PowerTeacher Pro to the  

Help Screen for the page on which you are currently 
Working.  So, if you are on the Scoresheet it will 

take you to the help screen for the Scoresheet.  If  
you are on Comment Verification it will take you to  

the Help Screen Comment verification.  If the Help 
screen opens to a topic for which you are not  

interested, you can use the left menu to select a 
topic or use the search function to navigate to the 

appropriate information.  
 
 

 

 

 

Tips and Tricks 

 

The Tips and Tricks link will take to the section of 

The Help Screens that offers directions on how to 
Optimize your usage of PowerTeacher Pro. 
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Getting Started 

 

Getting Started allows you  

to access the welcome screen 
for PowerTeacher Pro. 
 

 

 

 

 

 

 

What’s New 

 

What’s New will take you to a list of the  

Newest Features for the version of  
PowerTeacher Pro you are using. 
 

 

 

 

 

 

 

 

Videos 

 

Accessing the Video option will take you to the portion of  

PowerTeacher Pro Help where you can access available Video 
tutorials on how various aspects of PowerTeacher Pro function. 

 

 
 

 
4. Sign Out/Accessibility Options 

 
Clicking on the Teacher’s Name gives access to two options.   

First is the ability to Sign Out of PowerTeacher Pro.  The second allows 

the user to select the View size of data in PowerTeacher Pro.  There are  
now three options available, Small, Medium or Large.  The smaller the  

View selected the more information that will appear on the screen, the  
larger the View selected the less information that will appear on the screen. 

This setting applies to all applicable pages in PowerTeacher Pro. 
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Small View: 
 

 
 

                Medium View:            Large View:    

                    
 

 
5. Options Gear 
 

Click the options Gear        to access Options menus.  Functions available within the 
menu will vary based on which screen the user is on when accessing the link.  Available 

options include: 

 

GRADING 
 

• Grading > Assignments List  
 

o Show/Hide Filter - allows you to turn the filter option, at the  
top of the screen, on or off. 

 

 
 

o Copy Assignments – Allows you to copy assignments from a specific 

term/class to a different class or group of classes for a specific term.  
Teachers can also copy assignments, from PowerTeacher Gradebook, 

however, when using this option teacher cannot select individual 
assignments.  ALL assignments from PowerTeacher Gradebook will copy to 

PowerTeacher Pro.  The teacher will then need to edit/delete assignments 
that are not wanted. 



POWERTEACHER PRO USER GUIDE          
 

PREPARED BY:                                                      36         

How to Copy Assignments from PTP 
 

From the Options Gear at the top right of the Assignment and/or Scoresheet 
screen select the option to Copy Assignments. 

Once on the Copy Assignment screen select the following: 
 

 
From:  Select the TERM and Class from the respective drop downs for the  

           assignment(s) you wish to copy. 

 

 
 

 
 

 
 

TO:  Select the TERM and Class(es) from the respective drop downs for the term  

       and class for which you are copy the assignments into. 
 

  
 

 

 

 

Copy Options:  
 

Due Date:  Select the Due date from one of the available options. 
▪ Existing will use the original assignment date. 

▪ Relational will use a date that is proportional to when the original 
assignment was due as related to the term. 

▪ Custom allows the user to assign a new due date. 
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Choose Assignments: Choose the assignment(s) you wish to copy from one  
class to another.  The user can select all assignments by       

checking the box at the top left of the list or can select  
individual assignment to copy by checking the individual  

boxes to the left of each assignment. 

 
 

Click Copy Assignments to complete the process. 

 
 

• Grading > Assignment List > Select an individual 
Assignment 

 
o Show/Hide Summary – allows you to show/hide the  

assignment summary. 

 

 
 

o Show/Hide Metrics – allows the user to turn on/off assignment metrics of 

Mean, Median and Mode. 

 
 

o Show/Hide Standards – allows the user to show/hide standards 

associated to a given assignments. 
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o Export Scores Template – allows the user to export an assignment as a 
.csv file for grade entry outside of PowerSchool. 

 
 

 
 

o Import Scores – allows the user to import scores from spreadsheet or 
other application. 

 

 
 

 
 

 
 

 
 

 
 

 
Grading > Scoresheet View 

 
o Show/Hide Filter - allows you to turn the filter option,  

at the top of the screen, on or off. 

 
 

 

 
 

o Show/Hide Summary – allows you to show/hide the  
assignment summary. 

 
 

 

 

o Show/Hide Metrics – allows the user to turn on/off assignment metrics of 

Mean, Median and Mode. 
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o Copy Assignments – Allows you to copy assignments from a specific 
term/class to a different class or group of classes for a specific term. (See 

above for directions on how to Copy Assignments.) 
 

o Show Assignments from Most/Least Recent – allows you to sort 
assignments within the Scoresheet from newest to oldest or oldest to 

newest. 
 

o Recalculate Final Grades – allows you to recalculate Final Traditional or 

Standards grades for the selected class(es). 
 

 
 

 
 

 
 

 
• Grading > Traditional, Comment Verification 

or Reporting Terms 
 

o Show/Hide Summary – allows you to show/hide the  
Term summary. 

 

 
 

 
 

• Grading > Standards 
 

o Show/Hide Filter - allows you to turn the filter option,  
at the top of the screen, on or off. 

 
 

 
 

o Show/Hide Summary – allows you to show/hide the  
Term summary. 

 

 
 

o Show/Hide Metrics – allows the user to turn on/off assignment metrics of 
Mean, Median and Mode. 
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o Recalculate Final Grades – allows you to recalculate Final Traditional or 
Standards grades for the selected class(es). 

 
 

 
 

 
 

 

• Grading > Categories Totals 
 

 
o Show/Hide Summary – allows you to show/hide the  

Term summary. 
 

 
 

 
o Show All Categories/Show Categories for this section – allows you to 

view the category totals for All active categories or just the categories for  
the selected class. 

 
 

 

 
 

o Show/Hide Metrics – allows the user to turn on/off assignment metrics of 
Mean, Median and Mode. 

 
 

o Recalculate Final Grades – allows you to recalculate Final Traditional or 

Standards grades for the selected class(es). 
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STUDENTS 
 

• Students > Assignments 
 

o Show/Hide Filter – allows the user to turn the filter option, 

at the top of the screen, on or off. 
 

 
 

o Show/Hide Summary – allows the user to show/hide the  
assignment summary. 

 

 
 

o Show/Hide Details – allows the user to show/hide specific details for the 

selected student for the selected section.  This information includes Final 

Grade and attendance data for the student for the selected term. 
 

 

 

 

o Recalculate Final Grades – allows you to recalculate Final Traditional or 

Standards grades for the selected class(es). 
 

 
 

 
 

 
 

• Students > Standards Progress 
 

o Show/Hide Summary – allows the user to show/hide the  

Class summary. 
 

 

 

 

o Recalculate Final Grades – allows you to recalculate Final Traditional or 
Standards grades for the selected class(es). 

 
 

 

 



POWERTEACHER PRO USER GUIDE          
 

PREPARED BY:                                                      42         

• Students > Comment Log 
 

o Show/Hide Filter – allows the user to turn the filter option,  

at the top of the screen, on or off. 
 

 
 

o Show/Hide Summary – allows the user to show/hide the  

Term summary. 
 

 
 

 

o Recalculate Final Grades – allows you to recalculate Final Traditional or 
Standards grades for the selected class(es). 

 
 

 

 
 

 

 

 

 

 

 

6. Terms 
 

The terms list will display all terms that have been configured  
under the Final Grade/Reporting Term Setup screen on the Admin  

side of PowerSchool.  PowerTeacher Pro may default to the current 
term depending on how the Default Term is setup on the Admin  

side. If the correct term is not selected when the teacher logs into  
PowerTeacher Pro he/she can change the term by selecting it from  

The list. 
 

The term selected will determine which assignment, grades and/or standard grade 
information is displayed.  Ex:  If Q1 is selected only assignments, standards and grades 

entered for assignments with a due date that falls within the Q1 term will appear. 
 

Selecting ALL will allow the user to see a list of all assignments, standard and or grades 
for the entire year. 
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7. Grading 
 

Under the Grading option a user can look at Traditional Grades  
on two levels.  At the Assignment level and then at  

the Final Grades level.  At the Assignment level, teachers  
can work with assignments one at a time or they  

can view/edit assignments using the more traditional  
Scoresheet view.   

 

In addition, the Grading Section allows teachers to take a  
closer look at final calculated grades, both traditional and 

standards as well as view Final Grade Comments  
and Category totals. 

 

Assignments 

 
Start > Grading > Assignment List > Select Assignment 

Assignment List 

 

To get to the Assignment List 
 

1. Click on Grading from 
the Charms Bar. 

 
2. Click on Assignments. 

 
3. Select the class for which you wish to view assignments. 

 
 

4. Select the Reporting Term. 
 

5. The List of assignments for the selected/class term will display. 
 

6. Rows/Page shows the number of assignments visible on the page. 
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7. Edit the setup of an assignment by clicking on the pencil Icon in the Edit column. 
 

8. Use the Filter option to limit the assignments shown.  You can filter by any value 
shown on the page (Category, Assignment name, date due, score type, etc), as 

well as by Assignments that Need Scoring or are still Due. 
 

To Work with the Assigment click on the Assignment Name. 
 

 
 

1. The Information Bar gives the assignment setup information, Name, Score 

Type, Possible Points, Date Due, etc. 

 
2. Students - Lists students for whom the assignment is associated.  Clicking the 

arrow to the right will sort the students alphabetically A-Z or Z-A. 
 

3. Score – Column used to enter the Traditional Assignment Score. 
 

4. (Standards Identifiers) - Columns used to enter the score(s) for associated 
Standards.  Depending on Standards setup Teachers may need to enter the 

Standard Scores manually or they may be pushed out based on the Traditional 
Score. 

5. Metrics – If enabled would display the Mean, Median and Mode scores for each 
assignment. 

 
6. Edit Assignment - allows you to change the setup itme for this particular 

assignment. 

 
7. Show More - gives you a view of more information regarding this assignment. 

(See Below) 
 

 
 

 
 

 
8. Clicking on the drop-down arrow, at the top left of the screen, allows you to switch 

between assignments within the selected class. 
 

Click the Save button to save any changes made through the Assignment Screen. 
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Score Sheet 

 

Start > Grading > ScoreSheet 
 

The ScoreSheet offers a more traditional view of the Teacher’s gradebook, for those 
that are more comfortable with this type of grade entry. 

 

 
 

 

 

 

1.  The Information Bar contains, the Term, Calculation Method, Grade Scale and 
Grade/Earned Points/Possible Points for the selected student.  

 

2.  Use the Filter option to limit the assignments shown.  You can filter by any value 
(Column Heading or Row Data) shown on the page or by Date Range (Today, This 

Week, Last Week, This Month, Last Month). 
 

3.  Edit Assignment – Appears when you have clicked into the Grade Cell for a 
particular assignment.  This allows you to change the setup itme for this particular 

assignment.   
 

4.  Show More – Will  appear if you have clicked into the Grade Cell for a particular 
assignment or if you have  clicked into the Final Grade Cell or a student.  The data 

displayed will determine which type of Grade Cell you are in.  If you are in the  
Grade Cell for an Assignmet you will see information regarding this assignment. 

(See Below) 
 

 
 

 



POWERTEACHER PRO USER GUIDE          
 

PREPARED BY:                                                      46         

 
 

 
 

 
 

 
If you are in the Final Grade Cell for a student you will see information regarding the 

Class Setup. This contains information on Grade Scales, Special Codes and Formulas for 

how the Final Grade for the class is being calculated.  (See Below) 
 

a. Grade Scales – The Grade Scale Assigned to the Class 
 

   
 

b. Special Codes – These are any Special Character / Grade Codes that are 

being used by the course but are not part of the regular grade scale. 
 

 
 
 

 

c. Formula – This is the calculation method being used to calculate the Final 
Course grade for the term selected. 

 

 
 

5.   Metrics – If enabled would display the Mean, Median and Mode scores for each   

 assignment within the Scoresheet, as well as for the Final Course Grade. 

 
6.   Students - List of students enrolled in the selected class. 
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7.   Grade – This is the final calculated grade for selected term. 
 

8.   Assignments/scores contributing to Final Grade for selected Term. 
 

9.   Move to the Next Page – Within the Scoresheet view, Teachers can set the  
 number of assignment columns visible on the page. Currently, the maximum  

 number of columns that can be displayed at one time is 20.  If more assignments  
 have been created PowerTeacher Pro will start to Paginate. To move to the next  

 page, you can click on the Arrow to the upper right of the last column.  To move  

 back click on the arrow to left of the first column.   
 

While the Max number of columns that can be viewed on a given page is 20,    
setting the value to a number higher than 12 will require the Teacher to use the  

scroll bar at the bottom of the screen.  Note that in doing so the student names  
are not locked and when scrolling to the right you will no longer be able to see   

your class list.   
 

10. Pagination – As indicated above, PowerTeacher Pro now uses pagination to   
 move through assignments within the Score Sheet.  You can either Type the page   

 number to which you want to move or use the arrows to move through the page.   
 You can also set the Max # of columns to display on the page.  As noted above, if   

 set to anything greater than 12 columns the user need to scroll left to right.  In  
 doing so the Student names will not remain static and you will lose the ability to  

 see student names. 

 
11. Click the Save button to save any changes made through the Score Sheet. 
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Categories 

 

Start > Grading > Categories 

 
The Categories screen under the Grading section is similar to the View All tab under 

Create > Category with some additional functionality.  
 

 
 

1. Order – You can sort the order in which your categories are listed when creating 

assignments by using the arrows to move them up/down. 
 

2. Color – Color is assigned when the cateogry is created.  Assignments, when 
viewed in the score sheet, will be color coded based on the category assigned. 

 
3. Category Name – Name given to the Category. Category Names must be unique. 

 
4. Category Icon – If categories are created at the District Level and pushed out to 

users the Category Name column will display an icon of a school building.  Any 

Categoryies without this icon have been created by the teacher within his/her 
gradebook. 

 
5. Classes Using – This section will list what classes are using this category. When 

in this screen or in the View All under Category setup you will see ALL Categories.  
However, when creating assignmenst only categories associaed to all classes and 

that specific class will be available for selection. 
 

6. Active – This indicates if a category is Active or not. It is not possible to delete 
categories that have previously been used, but you can make them inactive so 

that they are not visible in the current Year.  See the section on Editing below. 
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7. Edit – This screen allows you to modify 
the setup for a specific category.  This  

screen is the same as the original Create 
Category screen as discussed earlier. 

 
8. Show Inactive – If checked the user  

can  see both active and inactive standards. 
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Grades 

Traditional  

 

Start > Grading > Grades > Traditional  
 

The Grades > Traditional Screen shows overall information for a selected term.  This 

screen includes not only the Calculated Final Grade for the selected term, but also 
accumulated attendance and then any assignments that may be flagged as Late, Missing 

or Incomplete. 
 

  

 
 

1. Grades – You can switch to the other “Grades” screens from within this view.  
Options include: 

• Traditional – Final Course grades 
• Standards – Final Standards grades 

• Comment Verification – One page view of all  

Final Grade Comments for the selected term. 
• Category Totals – Totals for students by category. 

• All Reporting Terms – Final Course grades for all 
Reporting Terms. 

 
2. The Information Bar on this screen will change depending on the column you are 

working in. By default, it contains the same information found in the Scoresheet 
view including: Term, Calculation Method, Grade Scale, Grade/Earned 

Points/Possible Points for the selected student. When working in the 
Citizenship column the values change to include:  Term, Grade Scale and Grade.  

Clicking on Show More allows more information regarding the Grade Setup for 
the class. As above, the available information will depend of whether you are 
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looking at the Final Traditional Grade or the Citizenship grade.  Available 
information to view includes: 

 
• Grade Scales – The Grade Scale Assigned to the Class 

 

   
 

• Special Codes – These are any Special Character / Grade Codes that are 

being used by the course but are not part of the regular grade scale. 

 

 
 

• Formula – This is the calculation method being used to calculate the Final 
Course grade for the term selected. 

 

 
 

• Citizenhip – This includes the Citizenship Grade Scale. 
 

 
 

3. Student Names – The list of students enrolled into the selected class or group of 

classes. 
 

4. Final Grades - Shows the Final Grade (either calculated or manually overwritten) 
for the selected term. See the section on Entering Grades 
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5. Variable Credit – Use this screen to enter the appropriate Variable Credit 
values for each student.  Note, for these columns to appear, Variable Credit 

musts be enabled at the section level on the Admin Side of PowerSchool.  Within 
each section, schools can enable the option to allow for Variable Credit Awarded, 

Attempted or both. 
 

6. Citizenship - Use this screen to enter the appropriate Citizenship code for each 
student by clicking into the grade cell in the in the Citizenship column and entering 

the appropriate score. 

 
7. Attendance shows the total number of absences or tardy codes for the selected 

term. 
8. Assignments shows the total number of assignments that have been flagged as 

either Missing, Incomplete or Late. 
9. Final Grade Status is used at the end of the term for teachers to identify that 

they have completed grade entry for the selected class.  By clicking on the button, 
a new window will open.   

 
Teachers will check the box in the upper right indicating that the Final Grades for 

the selected Term are complete.  They can also enter a comment regarding the 
Final Grades for the selected class.  This information can then be view via the 

Section Readiness Report from the Admin Portal. 
 

 
 
Click Save to save any changes made to the current page 
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Standards 

 

Start > Grading > Grades > Standards 

 
The Grades > Standards Screen shows overall information for a selected term.  This 

screen includes both the final, calculated Traditional Grade, and the Final, calculated 
Standards Grades, for the selected term.  If Standards Grades are not automatically 

calculated, the teacher would use this screen for Final Grade Entry. 
 

 
 

 
 

1. Grades – You can switch between the type of Final Grades you would like to 
view.  Options include: 

 
• Traditional – Final Course grades. 

• Standards – Final Standards grades. 
• Comment Verification – One page view of all  

Final Grade Comments for the selected term. 
• Category Totals – Totals for students by category. 

• All Reporting Terms – Final Course grades for all 
Reporting Terms. 

 
2. The information available under the Show More option changes depending on 

whether you have selected a Traditional Final Grade or a Standard Final Grade.  

If selecting a Traditional Grade, the available information to view includes: 
 

• Grade Scales – The Grade Scale Assigned to the Class 
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• Special Codes – These are any Special Character / Grade Codes that are 
being used by the course but are not part of the regular grade scale. 

 

 
 

• Formula – This is the calculation method being used to calculate the Final 
Course grade for the term selected. 

 

 
 

 
If a Standard Grade is selected the available information will include: 

 
• Description – This is the information contained in the Description field of 

the Standard 
 

 
 

• Hierarchy – The Order of Standards associated to the selected Standard. 
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• Grade Scale - The Grade Scale Assigned to the Standard. 
 

 
 

• Special Codes - These are any Special Character / Grade Codes that are 
being used by the course but are not part of the regular grade scale. 

 

 
 

3. Like the Traditional and Scoresheet views, the Information Bar contains, 

the Term, Calculation Method, Grade Scale and Grade/Earned 
Points/Possible Points for the Selected Student’s Traditional Grade.  

 
Additionally, when selecting a specific Standard grade, the Information Bar will 

change to show you full name of the Standard and the Grade Scale associated to 
the Standards. 

 
4. Filter - Use the Filter option to limit the assignments shown.  You can filter by 

any value shown on the page (Grade, Standard Identifer, student name, etc). 
 

5. Metrics allows you to see the Mean, Median and Mode for both the Final 
Overall Class Grade as well as for each individual Standard. 

 

6. Student Names - shows the Students from the selected class or group of 
classes. 

 
7. Final Grade - shows the Final Traditional Grade (Calculated or Overwritten) for 

the selected term. 
 

8. Standards Final Grades - Shows the Final Standards Grades (Calculated or 
Overwritten) for each standard/student the selected Term. 

 
9. Final Standard Grade Per Student – Click on the student grade to enable 

the Score Inspector.  Use the Score Inspector to manually overwrite the 
final grade and/or view the Standards Progress screen for the selected 

student/standard 
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Use the Score Inspector to manually overwrite the final grade and/or view the 

Standards Progress screen for the selected student/standard.   
 

 
 

10. Final Grade Status is used at the end of the term for teachers to identify   
 that they have completed grade entry for the selected class.  By clicking on  

 the button, a new window will open.   
 

Teachers will check the box in the upper right indicating that the Final Grades for 
the selected Term are complete.  They can also enter a comment regarding the 

Final Grades for the selected class.  This information can then be view via the 
Section Readiness Report from the Admin Portal. 
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NOTE:  The Standards screen now employs pagination in the same way as the 

Scoresheet view.  The maximum number of columns that can be displayed at one time is 
20.  However, the maximum number of columns that can be displayed without requiring 

scrolling is 11. 
 

Click Save to save any changes made to the current page. 
 

Comment Verification 

 

Start > Grading > Grades > Comment Verification 

 
Comment Verification allows a user to see Final Class Grades as well as Final Grade 

Comments in one place.  As with similar screens, the teacher can look at a single class, 
group of classes, or ALL classes in one location.  In addition, Final Grades and 

Comments can be manually entered/overwritten from this screen.  See the section 
below on Entering/Editing Grades and Comments.  As with the Traditional and 

Standards screens Teachers can also indicate that they have completed working with 

Final Grades. 
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Category Totals 

 

Start > Grading > Grades > Category Totals 

 
The Category Totals screen allows the user to view the Final Calculated Course score 

as well as the calculated total for all Categories used throughout the marking period.  If 
Category Weights are being used this gives users a good view of how the Final Grade 

has been calculated.  As with similar screens the Information Bar at the top can be 
expanded to show which Grade Scale(s) have been associated to the course as well as 

the calculation method for the class.  As with other Screens that show the Final Course 
grades, the final grade can be manually overwritten from this screen. 

 

 

All Reporting Terms 

 

Start > Grading > Grades > All Reporting Terms 

 

A similar screen to both the Traditional Grade, Comment Verification and Category 
Totals screen, the All Reporting Terms screen displays the Final Traditional (Course) 

grade for each Reporting term, for the selected year. As with all screens that display 
Final Grades, this too, will show if a grade has been manually overwritten by displaying 

a gray triangle in the upper left corner of the grade cell.  Likewise, if a comment has 
been entered there will be a blue comment balloon in the upper right. See the section 

below Entering/Editing Grades and Comments for further directions. 
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Students 

Assignments  

 

Start > Students > Assignments 
 

This screen allows a user to view/edit multiple assignments scores, for a single student, 

at one time.  This option can include assignments for a single class or multiple classes 
depending on the class or group of classes selected. 

 

 
 

1. The class selected at the top of the screen will determine which assignments are 

visible.  If a single class is selected, only the assignments for that class will be 
available.  If a group of classes is selected, all assignments for that group of 

classes will be available. 
 

2. Student Name – Allows the user the ability to select a different student or switch 
to a different screen within the Student menu. 

 
3. Details – This section shows specific detail information about this student for the 

class/classes selected.  If shown, it will include the Name and Section # of the 
course, the Overall Grade for the course, accumulated attendance totals, as well 

as the total number of Missing or Late assignments. 
 

4. The Information Bar gives the assignment setup information, Name, Score 
Type, Possible Points, Date Due, etc.  As with the Class Assignment screen 

the Information Bar also allows a user to Edit Assignments directly from this 

screen or select the Show More option to see Grade Scale information for each 
assignnment. 

 
5. Use the Filter option to limit the assignments shown.  You can filter by any value 

(Column Heading or Row Data) shown on the page or by Date Range (Today, This 
Week, Last Week, This Month, Last Month). 
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6. Assignment List – List of Assignments and associated Categories.  The list will 
inlclude assignmetns based on the class or group of classes selected at the top of 

the screen. 
 

7. Score – Use this column to Ener/View/Edit the student’s score for each 
assignment. 

 
8. Due Date – Displays the due date for each assignment. 

 

 
9. Standards – Displays the number of standards associated to the selected 

Assignment.  Clicking on the link will allow you to view the associated standards 
and scores.  Note that Standards Scores cannot be entered or edited from this 

screen. 
 

Standard Progress 

 

Start > Students > Standards Progress > Select Student 
 

The Standards Progress screen shows the “calculated” standards grades, for the 
selected student, for the selected term. By default, the column containing the current 

term’s grades is highlighted.  This screen allows a teacher to easily compare the grades 
the student received in each term. 

 

 
 

1. Switch between Students and/or screens within the Student View. 
 

2. Use the Filter to narrow the results to a standard(s) and/or grades. 
 



POWERTEACHER PRO USER GUIDE          
 

PREPARED BY:                                                      61         

3. The Information Bar shows basic information about the course such as 
Calculation Method, Score Type, and Grade. 

 
4. Standards shows the standards that are associated to the selected course. 

 
5. Term Grades show the “calculated” Final Standards Grades for the selected 

course.  If standares are not associated to assignments and graded then this 
column will be blank.  As with other Screens that show the Final Course grades, 

the final grade can be manually overwritten from this screen.   

 
6. Assignments shows the number of assignments associated to each standard for 

the selected term.  Clicking on the icon will take to you a more detailed 
Standards Progress Detail screen for the selected student. 

 
 
Standards Progress Detail 

 

 
 

 
1. Use this link to select the Standard for which you wish to view student data. 

 
Graphical Data 

 

The Graphical data shows you how a student has done on the selected 
standard, over the length of the selected term, as compared to the “calculated” 

Final Grade.  Note that the type of calculation being used is displayed at the 
bottom of the graph. 

 
2. The green dotted line represents the “calculated” Final Grade. 

 
3. This is a graphical view of the student’s progress for the selected standard 

for the selected term. 
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4. The Gear icon in the upper right allows the user to select additional Progress 
Options.   

 
 

 
 

 
 

 

 
 

 
 

 
 

1. Select an Additional Matrix to Graph.   
From the drop-down list, you can select  

an additional calculation value to graph  
against the defined value.   

2. Use the Filter to narrow the list of available  
Standards. 

3. Select additional standards to view on the 
graph 

 

 

 
 

5. Show Metrics allows you to see additional (calculated) information 

regarding this standard include the Most Recent, Mean, Median, Mode, 
Weighted Mean and Highest values. 
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6. The Information Bar shows the same information as the Information Bar 
for any standards screens.   

 

 
 

 

7. Show More allows the user to see additional Options include Description, 

Hierarchy, Grade Scale and Special Grade Codes. 
 

8. Assignments shows the assignments to which this standard has been 
associated. 

 

9. Score is the Traditional Grade earned on each assignment. 
 

10. Grade is the grade for the Standard associated to the assignment. 
 

Comment Log 

 

Start > Students > Comment Log 
 

The Comment Log is a screen that can be used to see ALL comments (both assignment 
and final grade) entered, for a student, for the selected term.  As will similar screens the  

Filter can be used to filter down to a specific comment and the Information bar at the 
top can be expanded to show which Grade Scale(s) have been associated to the course 

as well as the calculation method for the class.  As with other Screens that show the 
Final Course grades, the final grade can be manually overwritten from this screen. 
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1. Switch between Students and or screens within the Student View. 

 
2. Use the Filter to narrow the results to a specific comment(s). 

 
3. Information Bar that shows basic information about the course such as 

Calculation Method, Score Type, and Grade. 
 

4. Type/Category shows the type of Comment (either Final Grade or Assignment).  

If a Final Gade comment it will display as Class Grade with the Appropriate Term.  
If an Assignment comment it will show the category to which the assignment is 

associated. 
 

5. Comment Text shows the Name of the Term or Assignment as well as the text of 
the comment itself. 

 
6. Grade/Score displays the earned score for the term/assignment.  As with other 

Screens that show the Final Course grades, the final grade can be manually 
overwritten from this screen.  

 
7. Date shows the Date of the Assignment/Term of the final Grade comment. 
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Demographics 

 

Start > Students > Demographics 
 

The Demographics page allows teachers to see basic demographic information for each 
student.  The information available has been entered through PS Admin.  Teachers are 

not able to enter/update any information contained on this page. 
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Quick Lookup 

 

Start > Students > Quick Lookup 

 
The Quick Lookup Screen is available to both Admin Users and Teachers. This option 

gives teachers a single screen where they can view student progress and attendance for 
ALL classes in which a student is enrolled.   

 
From the Quick Lookup screen a teacher can: 

• Email another teacher. 
 

• See Attendance totals (absent and tardy) by class, as a total for all classes, 
or if enabled by the school the total Daily Attendance. 

 

• Click into the Final Term grade and view the Scores Detail screen. 
 

• This view can include both current enrollment as well as dropped classes. 
 

   
 

 

 

 

 
1. Use this link to switch to a different student or switch to a different screen within 

the Student View. 
 

• Switch Students - Click the Student name from  
 the left column.   

 
• Switch Screens (within the Student View) - Click on  

 the name of the screen from the  
 right column. 
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2. Email a teacher – Click on the Name of the teacher to  
Open up your default email editor. 

 
3. Final Term Grades – These columns show the Final 

Grade for each class for their respective term.  Clicking on the Final Grade will 
take you to the Scores Detail Screen for that class. 

 
4. Absences – These columns show the total Absences, to date, for the specified 

terms. 

 
5. Tardies – These columns show the total Tardies, to date, for the specified terms. 

 
6. Attendance Totals – Show the total number of Absences and/or Tardies for all 

classes for the specified terms. 
 

7. Two Week Attendance – These columns show the individual attendance codes 
entered for each class from the most recent two-week period. 

 

 
 

8. Show Dropped classes also – Click on this link if you wish to view information 

for classes from a student has been dropped. 

 
If Daily Attendance is being used by the school (this only works if using a Bridge Period 

for Attendance), the Attendance by Day section will appear on the Quick Lookup screen.  
  

9. Last Week – This will show the individual codes entered for the student for the 
previous two-week period. 

 
10. Absences – This column shows the total Daily Absences, to date, for the   

 specified terms. 
 

11. Tardies – These columns show the total Daily Tardies, to date, for the specified  
  terms. 
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Score Detail 
 

The Score Detail screen offers detailed information explaining how a student’s grade has 
been earned. 

 

 
 

1. Use this link to either changes students or to change screens within the Student   

  View. 
 

2. This is the Overall Course/Grade information and contains the name of the course,   
  teacher name, expression (period/day when class meets) and the Overall Final   

  Grade for the specified term. 
 

3. Teacher Comment is the Final Grade Teacher comment for the selected student  

  for the specified term. 
 

4. Section Description is used by the teacher to give general information regarding  
  the class.  This information can be updated as needed by the teacher within the  

  Gradebook. 
 

PowerTeacher Pro Assignments. 
 

5. Date Due gives the date the assignment was given. 
 

6. Category indicates the Teacher Category to which the assignment is associated 
7. Assignment Name gives the name of each assignment. 
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8. Codes is a set of columns that can display various items pertaining to grades and /  
  or codes entered for each assignment. 

 
•                   - Indicates that Standards have been associated to the   

                         assignment.  Click on the Icon to see the associated  
                         standards and scores.   

•                   - Indicates that the assignment has been collected but no score  
                         has been issued. 

 

•                   - Indicates the assignment was turned in late. 
 

•                   - Indicates that the assignment has not been turned in.   
 

•                             - Indicates that the student is exempt from the  
                                               assignment. 

 
•                   - Indicates that the student was absent when the assignment  

                    was collected.   
 

•                   - Indicates that the assignment was incomplete when  
   submitted.   

 
•                  - Indicates that the assignment is not being counted towards the  

                        final grade for the course.   

 
9. Score - is the actual score of the assignment and shows both Possible and Earned  

  points. 
 

10. Grade is the earned letter grade based on the score for the assignment. 
 

11. The last column indicates if there is an Individual Assignment Comment and /  
    or a Description on the Category or Assignment itself.  If either have been  

    entered the word VIEW will appear. Click on View to see the associated 
comments  

    /descriptions. 
 

 
 Score Comment:      Assignment Description:  
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Standards Grades 

 

Start > Students > Standards Grades 
 

The Standards Grade screen allows the Teacher to see the Final Standards Grades for 

every class in which a student is enrolled, even if he/she is not the teacher.  
 

 
 

1. Switch between Students and or screens within the Student View. 
 

2. Check the box, if desired, to display Standards with no grades associated. 
 

3. Select the Year for which you would like to display standards grades (only displays 

for years that have been associated to PowerTeacher Pro.) 
 

4. Use Expand All / Collapse All to help Navigate through the Standards screen. 
 

5. Current Sections Lists all sections in which a student is enrolled.  Note this screen 
contains information for ALL classes, not just the ones belonging to the teacher.  

Use the Arrow to the left of the course name to expand collapse the screen to see 
Standards and/or Grades. 
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6. Click on an individual standard score to open the View Standards Final Grade 

window.  The window contains more detailed information regarding the standard 
score. 
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Progress 

Traditional 

 

Start > Progress > Traditional 
 

The Progress > Traditional Screen shows grade distribution, for the selected 

class(es), for the selected term.  Additionally, you can see the accumulated number 

Missing, Late or Incomplete Assignments. 
 

 
 

1. The Graph shows the distribution of grades (based on the associated  
    Grade Scale)  for the selected class/classes. Clicking on any of the      

    lines on the graph will take you to a new, more detailed Distribution  
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    Screen.  This screen will show you: 
 

 
 

1. Score Distsribution for Each Term shows the distribution of grades (by   
    color) for each Term of the Year.  The current Term will be highlighted. 

2. The Student / Grade area will show each student with the current term  
    grade as well as the previous term grade.  Additionally, an arrow indicator  

    (Green or Red) will appear, between the term grades,to show whether the  
    student has improved or declined since the previous term. 

 

 
 

3. The Settings Gear can be used to define 
what appears in the Grades columnn of Scores  

Distribution View. The user has the ability to  
select whether or not to show: 

 
▪ Show Empty Grades – Display students 

even if they do not have a final grade for 
the current term. 

▪ Show Trend – Show the Green/Red arrow 
to indicate if a student has imporved or  

declined as compared to the selected term. 
▪ Trend Compared Against- Select the term against which you would like 

to compare the current term’s final grade. 

 
 

2. The Missing, Late, Incomplete boxes show the total number of  
    assignments within each category for the selected class. Clicking on  

    the any of these boxes will take the user to the Grades > Traditional  
Screen where the Teacher can then see which students have Missing,  

Late or Incomplete Assignements. 
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Standards 

 

Start > Progress > Standard 

 
The Progress > Standards screen displays the standards for the selected class(es) 

along with the distribution of grades for each standard. The grade distribution graph, 
then displays the current standards grades for the class. Quickly, teachers can see which 

standards need the attention and which are on track. Additionally, teachers can see how 
many times a standard has been assessed. You can click on the distribution graph for 

each standard to view the specific students being assessed, along with their progress by 

term. You can also view the assignments for each standard. 
 



POWERTEACHER PRO USER GUIDE          
 

PREPARED BY:                                                      75         

 
 

1. Standards – Shows the list of all standards associated to the selected 

class/classes. 
 

2. Grade Distribution – Shows, at a glance, how students have performed on 
each standard. 

 
3.  View Student Detail – Clicking on the Grade Distribution graph will take 

you to a more detailed view of how students performed for the selected 

standard. 

 
 

 

1. Score Distsribution for Each Term shows the distribution of grades   
   (by color) for each Term of the Year.  The current Term will be  

   highlighted. 

 
2. The Students / Grade list will show each student with the current  

    term grade, for the selected standards as well as the previous term    
    grade.  Additionally, an arrow indicator (Green or Red) will appear,  

    between the term grades,to show whether the student has improved  
    or declined since the previous term. 

 
3. The Settings Gear can be used to define 

    what appears in the  Grades columnn of  
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    Scores Distribution View. The user has  
       the ability to select whether or not to show: 

 
▪ Show Empty Grades – Display  

students even if they do not have a 
final grade for the current term. 

 
▪ Show Trend – Show the Green/Red 

arrow to indicate if a student is  

has improved or declined as compared  
to the selected term. 

 
▪ Trend Compared Against- Select the term against which you would like 

to compare the current term’s final grade. 
 

 
 

 

 
 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

Reports 

 

In PowerSchool Version 10.1.2 PowerTeacher Pro comes with four built in reports.  They 
include the Individual Student Report, the Multi-Function Report, the Scoresheet 

Report and the Student Roster Report.  When configuring any report in PTP the users 
will need to navigate through three different screens.  

  
1. Criteria – Use this screen to determine the specific student data to be 

included in the report. 
 

2. Students – Use this screen to select the student(s) for whom the report 
will be run. 
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3. Format – Uses this screen to set the formatting of the report including 
orientation, output type, top note, bottom note, etc. 

 

Individual Student Report 

 

Start > Reports > Individual Student Report 
 

The Individual Student Report is a report than can be generated either for a single 
student or group of students.  It can be used as a Progress Report, a report to list 

missing/late assignments, low grades, high grades, category totals or any combination 
of these items. 

 
Criteria - On the Criteria tab users will need to identify the following: 

 

1. Report Title – By default this report is called the “Individual Student Report” but 
it can be renamed. 

 
2. Classes – Select the class/classes for which you want the report to run.  For 

multiple classes click on the drop down and then check the box for the selected 
classes. 

 
3. Use Custom Classes – Check the box to use the teacher define Custom Display 

Name for each section. 
 

4. Include Students’ Full Schedule – Check the box to include grade information 
for all classes a student is enrolled in, not just the classes within the specific 

Teacher’s gradebook. 
 

5. Separate Report By Section, By Student/Separate Report by Student – 

Check the box to break out the report to a separate page for each section per 
student.  This option will return a .zip file with a separate report for each section 

for each student. (multiple files per student) 
If using the Include Student’s Full Schedule option then this option changes to 

Separate Report by Student.  This option will return a .zip file with one report 
per student. 

 
Depending on the options selected, there are times that you will be required to use 

this option.  If not selected PowerTeacher Pro will be unable to run the report 
because of size limitations. 

 
If not selected the report will generate a single report that page breaks on each 

student. 
 

6. Sort Options  

• Layout – Select how you would like the finished reports to sort.   
Options include: 
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o By section and then Student Name 
o By Student Name 

 
• Students – Select the order in which you would like the results sorted.   

Options include:   
o Gradebook Preference  

o Last Name, 
o First Name  

o Student Number 

• Assignments – Select how you want the Assignments sorted. 
Options include:   

o Due Date (Newest First) 
o Due Date (Oldest First) 

o Category and then Due Date (Newest First) 
o Category and then Due Date (Latest First) 

 
7. Data – What data would you like included in your report? 

 
• Areas to include – These options can be used in any combination  

 
o Course Grades and Attendance 

• Course Grade Comments (Only available if Course Grades and 
Attendance is selected.) 

• Citizenship (Only available if Course Grades and Attendance is 

selected.) 
o Standards Final Grades (Will list all standards graded and ungraded) 

o Assignments 
• Assignment Comments (Only available if Assignments is 

selected.) 
• Standard Scores (Only available if Assignments is selected.) 

o Category Totals 
 

 
• Show Percentages – Check to include, uncheck to exclude. 

 
• Show Assignments with No Data – Check to include, uncheck to exclude. 

 
• Include Standard Identifier – Check to include, uncheck to exclude. 

 

• Include Student Number with Student Name – Check to include, 
uncheck to exclude. 

 
8. Date Range – Date Range options will appear based on the options you chose 

under Data > Areas to Include. 
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• Standards/Course Grades – Select the Term(s) for which you want Final 
Standards and/or Course Grades to appear.  You can select ALL Terms or 

you can specify term(s).  If no term is selected it will default to the current 
term. 

 
• Assignment Date Range – Select the date range for which you would like 

to include assignments.   
Options include: 

 

o Full Class – Includes assignments for the entire length of the class to 
date. 

o Manual – Enter a Start and End date for the assignments you wish to 
include 

o Individual Reporting Term – Select the specific Term for which you 
want to print assignments. 

 
• Categories Totals– Select the date range for which you would like to 

include category totals. You can select ALL Terms, a specific Reporting Term 
or group of terms. 

 
9. Data Filters 

 
• Assignment Attributes – Determine which type of categories you would 

like to include.  The user can select any combination of Attributes.   

Options include: 
o Missing 

o Late 
o Incomplete 

o Collected 
o Absent 

o Exempt 
o Blank Grade (excluding Exempt) 

o Has Comments 
 

 
 

 
 

• Assignment Scores – There are various options for selection the type of 

scores to report.  Depending on the option selected additional input will be 
required. 

 
o No Filter – Includes all Assignment scores.  

o Grade Range – If selected identify the Max and Min Letter Grade a 
student can have earned on assignments. 

o Percent Range - If selected identify the Max and Min Percentage 
Grade a student can have earned on assignments  
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o Color Level Range- If selected identify the Max and Min Color (as 
determined by the Grade Scale) student can have earned on 

assignments 
o Specific Grades – If selected, choose the specific grade/grades a 

student can have earned on assignments 
 

• Assignment Categories – Select the category/categories for which you 
would like include assignments on this report. 

 

• Course Grades – If Selected use the same options as offered under 
Assignment scores above. 

 
o Grade Range – If selected identify the Max and Min Letter Grade a 

student can have earned on assignments. 
o Percent Range - If selected identify the Max and Min Percentage 

Grade a student can have earned on assignments  
o Color Level Range- If selected identify the Max and Min Color (as 

determined by the Grade Scale) student can have earned on 
assignments 

o Specific Grades – If selected, choose the specific grade/grades a 
student can have earned on assignments 

 
• Citizenship Grades – If Selected use the same options as offered under 

Assignment scores above. 

 
o No Filter – Includes all Citizenship scores.  

o Grade Range – If selected identify the Max and Min Citizenship score 
a student can have earned on assignments. 

o Specific Grades – If selected, choose the specific Citizenship 
grade/grades a student can have earned.  
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Students - On the Students Tab users will need to select the Student/Students for  
whom the report needs to be run. 

 
By default, the report will run for ALL students in the selected class/group of classes.  If 

you wish to run this for a specific student/group of students, you can: 
 

1. Include Dropped Students – Check the option to include dropped students in this 
report. 

 

2. Click on Add/Remove Students. 
 

3. Check the box to the right of student names for whom you wish to run the report.  
Uncheck the box to the right for the student names for student whom you do not 

wish to run the report. 
 

 
Format – The Format tab allows users to set some additional formatting options. 

 

1. Orientation - Set the Orientataion of the report to either Portrait or Landscape. 
 

2. Output - Set the Output type for the report.  Currently the only output type for 
this report is PDF. 

 
3. Page Break - Check if you would like the report to break between students.  This 

will allow each student’s printed report to begin on a new page. 
 

4. Exclude Row Shading - Check to Exclude Row Shading.  If checked the report 
will appear all white.  If left unchecked it will alternate each row of data between a 

white row and a gray row. 
 

5. Top Note – If you would like to include a Top Note (the same note at the top of 
each student’s report) check the box to include.  If you would like it to appear 

bolded check the box to bold.  Enter the text of the note in the text box.  Please 

note the Character Limit of 256 characters. 
6. Bottom Note – If you would like to include a Bottom Note (the same note at the 

bottom of each student’s report) check the box to include.  If you would like it to 
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appear bolded check the box to bold.  Enter the text of the note in the text box.  
Please note the Character Limit of 256 characters. 

 
7. Signature Line – If you would like to include a signature line at the bottom of 

each student’s report check the box to include.  This will put a place for a 
signature and date at bottom of each report. 

 

 
 
Once all options have been selected click Run Report.   
 

 

Multi-Function Assignment Report 

 

Start > Reports > Multi-Function Assignment Report 
 

The Multi-Function Report provides the teacher with a list of assignments and student 
scores.  It is an easy way to quickly find any students with missing, late or incomplete 

assignments. 
 

Criteria 
 

1. Report Title – By default this report is called the “Multi-Function Assignment 

Report but it can be renamed. 
 

2. Classes – Select the class/classes for which you want the report to run.  For 
multiple classes click on the drop down and then check the box for the selected 

classes. 
 

3. Sort Options  
 

• Students – Select how you want the finished report to sort. 
Options include:   
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o Gradebook Preference  
o Last Name, 

o First Name  
o Student Number 

 
 

 
• Assignments – Select how you want Assignments sorted. 

Options include:   

o Due Date (Newest First) 
o Due Date (Oldest First) 

o Category and then Due Date (Newest First) 
o Category and then Due Date (Latest First) 

 
4. Data – What data would you like included in your report? 

 
• Show Percentages – Check to include, uncheck to exclude. 

 
• Show Assignment Comments – Check to include, uncheck to exclude. 

 
5. Date Range – Date Range options will appear based on the options you chose   

 under Data > Areas to Include. 
 

• Assignment Date Range – Select the date range for which you would like 

to include assignments.  You can select: 
 

o Full Class – Includes assignments for the entire length of the class to 
date. 

o Manual – Enter a Start and End date for the assignments you wish to 
include 

o Individual Reporting Term – Select the specific Term for which you 
want to print assignments. 

 
6. Data Filters 

 
• Assignment Attributes – Determine which type of categories you would 

like to include.  The user can select any combination of Attributes.  Options 
include: 

o Missing 

o Late 
o Incomplete 

o Collected 
o Absent 

o Exempt 
o Blank Grade (excluding Exempt) 
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• Assignment Scores – There are various options for selection the type of 
scores to report.  Depending on the option selected additional input will be 

required 
o Grade Range – If selected, identify the Max and Min Letter Grade a 

student can have earned on assignments. 
o Percent Range - If selected, identify the Max and Min Percentage 

Grade a student could have earned on the assignments. 
o Color Level Range- If selected, identify the Max and Min Color (as 

determined by the Grade Scale) student can have earned on 

assignments. 
o Specific Grades – If selected, choose the specific grade/grades a 

student can have earned on assignments 
 

• Assignment Categories – Select the category/categories for which you 
would like include assignments on this report. 

 
 

 
 

Students - On the Students Tab users will need to select the Student/Students for 
whom the report needs to be run. 

 
By default, the report will run for ALL students in the selected class/group of classes.  If 

you wish to run this for a specific student/group of students, you can: 
 

1. Include Dropped Students – Check the option to include dropped students in this 
report. 

 
2. Click on Add/Remove Students. 
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3. Check the box to the right of student names for whom you wish to run the report.  
Uncheck the box to the right for the student names for student whom you do not 

wish to run the report. 
 

 
 

 
Format – The Format tab allows users to set some additional formatting options. 

 
1. Orientation - Set the Orientataion of the report to either Portrait or Landscape. 

 
2. Output - Set the Output type for the report.  Currently the only output type for 

this report is PDF. 
 

3. Page Break - Check if you would like the report to break between students.  This 

will allow each student’s printed report to begin on a new page. 
 

4. Exclude Row Shading - Check to Exclude Row Shading.  If checked the report 
will appear all white.  If left unchecked it will alternate each row of data between a 

white row and a gray row. 
 

5. Top Note – If you would like to include a Top Note (the same note at the top of 
each student’s report) check the box to include.  If you would like it to appear 

bolded check the box to bold.  Enter the text of the note in the text box.  Please 
note the Character Limit of 256 characters. 

 
6. Bottom Note – If you would like to include a Bottom Note (the same note at the 

bottom of each student’s report) check the box to include.  If you would like it to 
appear bolded check the box to bold.  Enter the text of the note in the text box.  

Please note the Character Limit of 256 characters. 
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Once all options have been selected click Run Report.   

 

Student Roster 

 

Start > Reports > Student Roster 
 

The Student Report is a report than can be generated either for list of students along 
with available demographics data as well as blank columns. 

 
Criteria - On the Criteria tab users will need to identify the following: 

 

1. Report Title – By default, this report is called the “Individual Student Report” but 
it can be renamed. 

 
2. Classes – Select the class/classes for which you want the report to run.  For 

multiple classes click on the drop down and then check the box for the selected 
classes. 

 
3. Sort Options  

 
• Students – Select the order in which you would like the results sorted. 

Options include:   
o Gradebook Preference  

o Last Name, 
o First Name  

o Student Number 

 
4. Display – What data would you like included in your report? 
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• Columns – Select what information you would like each column to contain. 
Click Add to add that column to the report. 

 
o Blank columns 

 
o Student Data Course Name 

• Birthday 
• Gender 

• Grade Level 

• Student Number 
 

o Parent Data* 
• Mother’s Name 

• Father’s Name 
• Home Phone 

• Guardian Email 
• Emergency Contact 1 

• Emergency Contact 1 Phone 
• Emergency Contact 2 

• Emergency Contact 2 Phone 
 

*Parent data will only be pulled from the default Parent fields.  It will not be pulled  
  if the data is stored in custom fields. 
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Students - On the Students Tab users will need to select the Student/Students for 
whom the report needs to be run. 

 
By default, the report will run for ALL students in the selected class/group of classes.  If 

you wish to run this for a specific student/group of students, you can: 
 

1. Include Dropped Students – Check the option to include dropped students in this 
report. 

 

2. Click on Add/Remove Students. 
 

3. Check the box to the right of student names for whom you wish to run the report.  
Uncheck the box to the right for the student names for student whom you do not 

wish to run the report. 
 

 
 

 
Format – The Format tab allows users to set some additional formatting options. 

 
1. Orientation - Set the Orientataion of the report to either Portrait or Landscape. 

 
2. Output - Set the Output type for the report.  Currently the only output types for 

this report is PDF or Excel. 
 

3. Page Break - Check if you would like the report to break between students.  This 
will allow each student’s printed report to begin on a new page. 

 
4. Exclude Row Shading - Check to Exclude Row Shading.  If checked the report 

will appear all white.  If left unchecked it will alternate each row of data between a 

white row and a gray row. 
 

5. Top Note – If you would like to include a Top Note (the same note at the top of 
each student’s report) check the box to include.  If you would like it to appear 

bolded check the box to bold.  Enter the text of the note in the text box.  Please 
note the Character Limit of 256 characters. 
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6. Bottom Note – If you would like to include a Bottom Note (the same note at the 
bottom of each student’s report) check the box to include.  If you would like it to 

appear bolded check the box to bold.  Enter the text of the note in the text box.  
Please note the Character Limit of 256 characters. 

 
 

 
Once all options have been selected click Run Report.   

 

Scoresheet Report 

 

Start > Reports > Scoresheet Report 
 

The Scoresheet Report is a report than can be generated either for a single student or 
group of students.  It can be used as a Progress Report, a report to list missing/late 

assignments, low grades, high grades, category totals or any combination of these 
items. 

 
Criteria - On the Criteria tab users will need to identify the following: 

 
1. Report Title – By default this report is called the “Individual Student Report” but 

it can be renamed. 
 

2. Classes – Select the class/classes for which you want the report to run.  For 
multiple classes click on the drop down and then check the box for the selected 

classes. 

 
3. Student Field – Select what student data you would like to include.           

    Options Include:   
 

• Student Name 
• Student Number 
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4. Sort Options Students – Select the order in which you would like the results  
    sorted.   

    Options include:   
 

o Gradebook Preference  
o Last Name, 

o First Name  
o Student Number 

 

5. Items to Include – Select the data you want to like included in your report. 
 

• Categories – Select the category/categories you would like to include in the 
report.  

 
• Final Grades – Select the Term(s) for which you want Final Grades to print. 

 
• Date Range – Select the date range for which you want assignments to 

print.  
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Students - On the Students Tab users will need to select the Student/Students for 
whom the report needs to be run. 

 
By default, the report will run for ALL students in the selected class/group of classes.  If 

you wish to run this for a specific student/group of students, you can: 
 

1. Include Dropped Students – Check the option to include dropped students in this 
report. 

 

2. Click on Add/Remove Students. 
 

3. Check the box to the right of student names for whom you wish to run the report.  
Uncheck the box to the right for the student names for student whom you do not 

wish to run the report. 
 

 
 

 

 
Format – The Format tab allows users to set some additional formatting options. 

 
1. Orientation - Set the Orientataion of the report to either Portrait or Landscape. 

 
2. Output - Set the Output type for the report.  Currently the only output type for 

this report is PDF. 
 

3. Page Break - Check if you would like the report to break between students.  This 
will allow each student’s printed report to begin on a new page. 

 
4. Exclude Row Shading - Check to Exclude Row Shading.  If checked the report 

will appear all white.  If left unchecked it will alternate each row of data between a 
white row and a gray row. 

 

5. Top Note – If you would like to include a Top Note (the same note at the top of 
each student’s report) check the box to include.  If you would like it to appear 

bolded check the box to bold.  Enter the text of the note in the text box.  Please 
note the Character Limit of 256 characters. 
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6. Bottom Note – If you would like to include a Bottom Note (the same note at the 
bottom of each student’s report) check the box to include.  If you would like it to 

appear bolded check the box to bold.  Enter the text of the note in the text box.  
Please note the Character Limit of 256 characters. 

 
7. Signature Line – If you would like to include a signature line at the bottom of 

each student’s report check the box to include.  This will put a place for a 
signature and date at bottom of each report. 

 

 
 
Once all options have been selected click Run Report.   
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Settings 

Student Grade Scales 

 

Start > Settings > Setup > Student Grade scales 
 

When enabled by your district administrator, Teachers can apply a different grade scale 
to specific students within each class. The grades scales available must be defined at the 

district level. 

 

When assigned, an orange triangle indicator will appear, in the upper right corner of the 
box containing the student’s name, in any screen where a class roster appears. 

(Assignments, ScoreSheet, Traditional, Standards, Comment Verification, Category 

Totals and All Reporting Terms.)  

 

When scoring an assignment, the score inspector will display a message indicating that 

the student has a custom grade scale assigned. 

  

1. On the menu bar, select Settings, 

and then choose Student Grade Scales. 

 

 

 

 

 

 

2. Click the arrow next to the class name to expand the class view. Any Student 

Grade Scales already assigned for the class will appear. If no grade scales exist, a 

message appears. 

No Grade Scales assigned: 
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 Student Grade Scales Assigned 

 

3. To apply a specific grade scale to a student or students, Click Add. 

 

4. On the Choose Students and Grade Scales  
window, select the appropriate grade scale  

from the menu. 
 

5. Use the Filter field to reduce the list of  
students. For example, type "A" to reduce  

the list to only students with the last name  
that begins with "A". 

 

 
 

 
 

 
6. Select the checkbox next to each student  

for who you wish to assign the selected  
grade scale.  Click the checkbox at the top  

of the column to select all. 
 

7. Select Save.  
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8. If a new grade scale is applied mid-term,  

 the following message will appear.   

 
 Note that the new grade scale will ONLY apply 

 to assignments created after the new grade  
 scale has been applied.  It cannot be applied to  

 assignments/scores already entered. 
 

 Click Save Changes to proceed. 
 

 

  

 
Once the new grade scale has been assigned  

to a student, you will see an orange 
triangle in the upper right corner of the  

student’s name cell. 
 

 

 
 

 
 

 
 

 
When entering assignment scores, the Score Inspector will indicate if a student is 

using a Student Grade Scale.  The available entry options will display based on the 
grade scale assigned to the student. 

 
Score Inspector – Student Grade Scale Score Inspector – Class Grade Scale 
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Display Setup 

 

Start > Settings > Setup > Display Setup 
 

 
Use the Display Settings page to configure the layout of items in the Gradebook. 

 

 

 
 
1.  Class Names  
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• Display and Sort – This will determine the Order the Classes are displayed in 

PowerTeacher Pro.  If using Custom Display Names for sections.  Teachers will 
enable the option by selecting the appropriate option from the drop down. 

 
 

 
 

 

 
 

 
 

•  Period/Day will display the Period/Day combination for each class and 
then sort classes first by the Period they are scheduled and then the 

day.   
 

   Ex:   P1(A) 
P2(A) 

P1(B) 
 

 
• Section Number (sort by Number) will display the Section number of 

each class and then sort numerically/alphabetically by the section 

number. 
• Section Number (sort by course name) will display the section number 

then sort alphabetically by the course name. 
• Custom Name (sort by course name) will display the Period/Day 

combination for each class as well as the Custom Display name.  It will 
then sort alphabetically by the Custom Display name. 

•  Custom Name (sort by Period/Day) will display the Period/Day 
combination for each class as well as the Custom Display name. It will 

then sort first by the Period they are scheduled and then the day. 
 

2. Standards Grades 
 

•   Show Standards Pages and Links – Check the box so that Standards pages  
  are visible in PTP. 

•   Show Standards on Assignments – Check the box so that Standards  

  appear with Assignments view. 
•   Auto Calculate Assignment Standards Scores Initial State – Options   

  checked or unchecked. 
 

 
 

 
               If checked then Standards grades will automatically be populated from the  
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               assignments score, if unchecked the standard score will need to be  
               manually entered.  Note that if the option is changed to checked after  

      assignments/standards have been entered, PTP will not push scores for  
      assignments that were previously created. 

 
•   Navigation Links Sort Order – This option will change 

      the order in with the labels appear under the Progress 
  Screen. 

 

 
 

 
 

•  Professional Judgement Indicator – If using standards grades, the   
  Professional Judgment Helper is designed to help you in assessing standards  

 grades. When enabled, the last three standards grades are evaluated to  
 determine if the student scored higher than the standards final, calculated  

 Standards grade. The indicator        helps you quickly see which grades to  
 focus on to determine if the final grade accurately reflects the student’s level of  

 understanding. 
 

 Using your professional judgment, you can decide if any changes need to be   
 made to the final grade.  

 
 

3.   Traditional Grades 
 

•   Show Traditional Grades on PowerTeacher Pro Screens – Check to show  
  Traditional Grades, Un-check to hide them.  Unchecking this option will  

  remove the Traditional Final Grade Column from affected screens. 
 

 
 

   
•   Values to Show in the Traditional Grade Column – Select the options for  

  the way you want Final, Traditional Grades to appear in the Grade Column.   

  Options include:   
 

• Grade – Letter Grade from Grade Scale 
• Percent – Calculated Percent Score 

• Points – Points earned/Points Possible 
  

 
4.  Student Names 
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•  Display – Determine the way you would like student names to display in PTP.   

 Options include: 
• Last, First 

• Last, First M. 
• Last, First Middle 

• First Last 
• First M. Last 

• First Middle Last 

 
 

 
 

•  Sort Students By – Determine the order in which you would like Student  
 Names to appear the Assignment and Score Sheet view.  Options include: 

 
• Last Name 

• First Name 
• Grade Level, then Last Name 

• Grade Level, then First Name 
 

 
 

•  Additional Sort Options include the ability to add newly enrolled students to  

 the bottom of the list (check the box to enable) and to Hide Pre-Registered  
 students (check to hide).   

 
5.  Save – Click Save to save any changes made to the Display Setup. 

 

Class Description 

 

Start > Settings > Setup > Class Description 
 

The Class Description screen displays basic information about each course including 

such items as Course Name/Number, Section Number, and Period the class meets, 
Start and End Date, Term of class and Grade Scale.  It is on this screen that 

teachers can add a Custom Class Name to be used to more easily identify one section 
from another.  Additionally, there is a Description box which the user can enter 

information that will be visible on the Scores Detail Screen of the Quick Look and/or 
Parent Portal Grades and Attendance screen.  The Class Description does offer additional 

formatting options including the option to create a “Link” to data stored in a different 
location.  Note that each class is included on this screen and is accessible by clicking on 

the arrow to the left of the course.  Descriptions entered are specific to the course for 
which they are entered.  If a teacher wishes to have a description for each class, he/she 

must enter the information into the Description box for each class. 
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Traditional Grade Calculation 

 

Start > Settings > Setup > Traditional Grade Calculation 

 
This screen allows the user to enter/view/edit the Traditional Grade Calculation for 

each class.  New with PowerTeacher Pro is the ability to push out Traditional Grade 
Setup from the District/School level.  If done, teachers will not have to go in and 

manually configure the Grade Setup.  If the Traditional Grade Setup is done at the 
District Level, they can determine if teachers will be given the option to modify the 

grade setup or not.  If setup is not done by the district teachers will need to setup the 
specific weighting for EACH term in EACH class.  This can be done term by term, section 

by section or teachers can use the Copy Grade Setup option. 
 

 
 

1. Use the Expand All/Collapse All buttons to open/close the calculations 

windows for each class. 

 
2. Use the arrow to the left of the course name to open the window to allow for 

calculation setup. 
 

3. Reporting Term lists the Reporting Terms as seen in the Teacher’s Gradebook. 
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4. Formula Type – Shows the defined calculation method.  If no method is 
defined it will default to Total Points. 

 
5. Edit Scale, if checked, lets the teacher know that he/she can create/modify a 

calcultion for the selected term. 
 

6.  Edit Drops, if checked, lets the teacher know that he/she can set whether they 
want to drop the lowerst score for a student. 

 

7.   Click on the Actions icon to setup/modify the exiting Grade Calculation Method 
for the selected term.   

 

8. Copy Traditional Grade Calculation – Use this function to copy grade setup 
from one term to another and/or one section to another.  

Actions – Formula 

 

The types of available calculation methods will vary depending on the Reporting Term 
selected.  All terms have the basic options of Total Points, Standard Weighting and 

Category Weighting but Terms that encompass shorter Terms also include the option for 
Term Weighting. 

 
 

 
 

 
 

 
 

 

 
 

1. Select Formula if defining the Formula. Select Drop Low Scores if 
configuring which scores, if any, to drop. 

 
2. Calculate Overall Class Grade – Check to enable, uncheck to disable.  This 

will allow you to see an overall class average for based on the final grade for 
all students. 

 
3. Click Add to add additional rows to the Calculation method.   This is most 

commonly used with Term and Category Weighting. 
 

4. Select the Type of Weighting to be used.  Options include: 
 

• Total Points – All asssignments set to be included in the final grade will 

be inclulded.  The final grade will be determined by adding up the total 
number of earned points and dividing it by the total number of possible 
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points.  If assignment weighting is applied to any assignment, that 
weighting will be applied prior to the final calculation.  This calculation 

met does not take into account standards and/or the categories to which 
assignmentes are assoicated.   

 
For this method there will be only one row within the method, the weight 

will be set to 1 and the percent to 100% 
 

• Standards Weighting – The final grade for a course can be determined 

based on the final standards scores rather than assignment scores.  If 
selected there are various options for determining the final grade. 

 
 

 
o Mean – This is the average of all Standards that have Final Grades 

associated. 
o Median – This is the middle average of all Standards that have 

Final Grades associated. 
o Mode – This is the most common score for all Standards that have 

Final Grades Associated. 
o Highest – This is the highest earned score for all Standards that 

have Final Grades associated 
o Specific Weights – If Specific Weights is selected then the weight 

for each standard being included must be setup on the Admin Side 

of PowerSchool.  Teachers do not have the ability to modify which 
stanadards are included in this calculation or how they are being 

averaged together. 
o Specific Sum – If Specific Sum is selectedthen the weight of each 

standard being included must be setup on the Admin Side of 
PowerSchool. Teachers do not have the ability to modify which 

standards are included in this calculation or how they are being 
averaged together. 

 
For this method there will be only one row within the method, the weight 

will be set to 1 and the percent to 100%.  As mentioned above if Specific 
Weight or Specific Sum is used those values are defined at the district 

level. 
 

• Category Weighting – The Final grade for a course can be calculated 

based on the average from pre-defined categories.  As a teacher adds 
assignments to each category the final grade will adjust based on the 

score of the assignment and the category to which it is associated.  (Ex:  
Test = 50%, Quizzes = 25%, Classwork = 15%, Homework =10%).  In 

all cases, the total of all categories must equal 100%.   
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For this method there will be onr row per category.  The weight for each 
category must be defined with the total weight of all categories equalling 

100%. 
 

• Term Weighting – This option is only availble if there are lower 
(shorter) Terms tied to this class.  Ex. Y1 is calculated from S1/S2, S1 is 

calculated from Q1/Q2, etc. 
 

For this method there will be one row per Reporting Term being included 

in the calculation.  The weight needs to be set to the value of each term.  
Ex:  If Y1 is made up of Q1, Q2, Q3 and Q4 then set the Weight for each 

term to 25%. 
 

 
 

Additionally, Term Weighting offers the teacher the additional option of 
defining whether they want the final grade calculated based on the Exact 

Value Earned (this is the Percent score) or the Term Weighting Points 
(this would show the final grade based on the corresponding GPA Points). 

 

 
 

5. Weight – Define the weight of the specified category or term. (Ex: Test = 

50%, Quiz = 25%, etc.) 
 

6. Percent – This field will auto calculate based on the value entered in the 
weight column. 

 
7.             Click on the – to delete the row from the calculation method. 

 
 

Actions – Drop Low Scores 

 

When using either any calculation method, other than Term Weights, Teachers have the 
option to Drop Low Scores for any given class.  There are several options the teacher 

can choose from when using this function. 
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Low Scores – Teachers can define the way in which PowerTeacher Pro drops scores.  

• Lowest Grade or Percent will drop the lowest score regardless of the 
assignments weight 

• Student Advantage will drop the score regardless of weight or category 
that will give the student the best advantage.  

 
 

 

 
 

 
 

 
Drop Low Scores – There are three options from which the teacher can choose. 

 
• None – No scores are dropped. 

 
 

 
 

 
 

 

• Drop Lowest Overall – If selected 
The teacher must define the number 

of scores to drop. 
 

 
 

• Drop Lowest by Category -  

If selected the teacher must  
select not only which categories  

(there can be more than one) but  

also how many scores to drop. 
 

 
 

 
Copy Traditional Grade Setup 

 
Once Grade Setup has been completed for one term or one class you can use the Copy 

Traditional Grade Setup Function to copy the setup into additional terms/sections. 
 

Copying Term to Term. 
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1. Click on the Gear icon in the upper right corner of the screen.  
2. Click on the Copy Traditional Grade Calculation link to open the 

copy function. 
 

 
 

 

A. Select Within A Class. 
B. Select the Class from which you are copying grade setup. 

C. Select the Term setup you wish to copy. 
D. Selct the Terms to which you want to copy the orignal setup. 

E. Check if you wish to recalculate Final Grades for the selected 
term. 

 
Click Validate. The Validation scren will appear.  If all is good 

then click Copy to complete the copy Process. 

 

 
 

A Validation Bar will appear at the top of the screen indicating that the 

Copy has been successful. 
 

 
 

 
 

 
 



POWERTEACHER PRO USER GUIDE          
 

PREPARED BY:                                                      107         

 
 

 
 

 
 

 
 

 

 
 

 
 

 
 

Copying Class to Class 
 

3. Click on the Gear icon in the upper right corner of the screen.  
4. Click on the Copy Traditional Grade Calculation link to open the 

copy function. 
 

 

 
 

 

 
 

 
 

 
 

F. Select To Another Class. 
G. Select the Term from which you want to copy.  

H. Select the Class from which you want to copy. 
I. Select the Term to which you wish to copy. 

J. Selct the Classes to which you want to copy. 
K. Check if you wish to recalculate Final Grades for the selected 

term/class. 
 

Click Validate. The Validation scren will appear.  If all is good 

then click Copy to complete the copy Process. 
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A Validation Bar will appear at the top of the screen indicating that the 
Copy has been successful. 

 
 

 
 

 

Standards Grade Calculation 

 

Start > Settings > Setup > Standard Grade Calculation 
 

 

This screen allows users to enter/view/edit the Standards Grade Calculation for each 

class.  New with PowerTeacher Pro is the ability to push out Standards Grade Setup from 
the District/School level.  If done, teachers will not have to go in and manually configure 

the Grade Setup.  If the Standards Grade Setup is done at the District Level, they can 
determine if teachers will be given the option to modify the grade setup or not.  If setup 

is not done by the district, teachers will need to configure the Standards Grade setup for 

every class individually. 
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1. Use the Expand All/Collapse All buttons to open/close the calculations 

windows for each class. 
 

2. Use the arrow to the left of the course name to open the window to allow for 
calculation setup. 

 
3. Standards Grades – Default Calculation – From the drop down list, select 

the calculation method that should be used by the selected class for calculating 
the Final grade for each associated standard.  The calculation options include: 

 
o Most Recent – Uses the most recent # of scores to calculate the Final 

Grade.  If selected the user must complete the next section to identify how 

many scores to include in this calculation. 
o Mean – This is the average of all Standards that have Final Grades 

associated. 
o Median – This is the middle average of all Standards that have Final Grades 

associated. 
o Mode – This is the most common score for all Standards that have Final 

Grades Associated. 
o Weighted Mean – This calculation works like category weighting for 

Traditional grades.  If selected the Final Grade will be determined using the 
same weighing settings as defined under Category Weights for Traditional 

Grades. 
o Highest – This is the highest earned score for all Standards that have Final 

Grades associated 
o None – No calculation is used.  Final Standards grades will not be 

calculated. 

 
4. Most Recent Scores Calculation – Number of Scores -  If Most Recent is 

selected as the Default Calculation Method, click on the Pencil Icon         to set 
the number of scores to be used and the weighting of scores (if desired). 
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5.  Click on the Pencil Icon to open the window 

 
6. Select the number of scores to be included in the Final Grade 

Calculation. 

 
7. Enter the weight (if other than 1) for each standard.  If all 

standards are to be counted equally, leave the value set to 1. 
 

5. Auto Calculate Higher Level Standards – Use this function if you would like 
Higher Level Final Standard Grades to be calculated based on the scores of 

Lower Level Standards.   
 

Example:  English Language Arts has 3 lower level standards: 
 

o Reading Literature 
o Reading Information Text 

o Writing 
 

If Auto Calculate Higher Level Standards is selected then the score for 

English Language Arts will be calculted using the scores of the 3 lower level 
Standards.   

 
To enable this function: 

 
1. Check the box to Auto Calculate. 

 
2. Use this Metric - Select the Calculation Method to be used.   

    Options include: 
 

• Mean – This is the average of all lower level Standards that 
have Final Grades associated. 

• Median – This is the middle average of all lower level Standards 
that have Final Grades associated. 

• Mode – This is the most common score for all lower level 

Standards that have Final Grades Associated. 
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• Highest – This is the highest earned score for all lower level 
Standards that have Final Grades associated 

• Specific Weights – If Specific Weights is selected then the 
weight for each standard being included must be setup on the 

Admin Side of PowerSchool.  Teachers do not have the ability to 
modify which stanadards are included in this calculation or how 

they are being averaged together. 
• Specific Sum 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Apps 

 
PowerTeacher Portal 

 
Start > Apps > PowerTeacher Portal 

 
Use the PowerTeacher Portal link to return to the PowerTeacher Start Page. 
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Entering Grades and Comments 

 

PowerTeacher Pro allows for student scores and comments to be entered in a variety of 

locations. Most commonly, teachers will use the Assignment view and Scoresheet View 
in the Grading Section to enter grades while Final Comments can be entered through 

where the Final Grade appears.    

 
The Assignment view will allow the teacher to view one assignment at a time.  Both 

assignment and standard scores can be entered using this view.  The more common 
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Scoresheet view allows teachers to view multiple assignments at one time, however, 
only assignment scores can be entered in this view. 

 
The ability to manually overwrite both Traditional and Standards Finals grades also 

exists and is not limited to just the Scoresheet or Assignment Views.  Traditional Final 
Grades can be manually overwritten on all Screens in the Grading Section except the 

Category screen. And in the Students Screens in the Comment Log. 
 

Final Standards Grades can be overwritten using the Standards screen in The Grading 

Section and the Standards Progress screen in the Student Section. 
 

Traditional – Assignment Scores 

 

Traditional Assignment Score entry, as mentioned above, can be completed from either 

the Grading > Assignment screen, the Grading > Score Sheet or the Student > 
Assignment screen.   

 
• Class Assignment – Teachers can enter scores for a single assignment for 

multiple students.  If the same assignment has been linked to multiple classes that 
teacher can enter grades for ALL students at one time rather than having to switch 

from one class to another. 
 

To Enter Scores: 
 

1.  Select the class or group of classes from the top of the screen. 
2.  Go to Grading > Assignments 

3.  Select the Assignment for which you want to enter grades. 
4.  Enter the scores either by typing the grade directly into the 

grade cell or by using the Score inspector (see section on Score 

Inspector below).  The first column is always the Traditional 
Assignment score, if Standards are associated a column for each 

standard will appear to the right.  (See section below on how to 
enter Standards Grades.)  
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• ScoreSheet – Teachers can enter scores for multiple assignments, for multiple 
students.  The students that appear on the score sheet will depend on the 

class/group of students that have been selected. If multiple classes have been 
selected the list of students will include students from all classes.  Note that 

Standard scores cannot be entered in the Scoresheet View.  
 

To Enter Scores: 
 

1.  Select the class or group of classes from the top of the screen. 
2.  Go to Grading > Scoresheet 

3.  Put the cursor in the first, blank grade cell of the assignment 

for which you want to enter scores. 
4.  Enter the scores either by typing the grade directly into the 

grade cell or by using the Score inspector (see section on 
Score Inspector below).  
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• Student > Assignment – Teachers can use this screen to enter scores for 
multiple assignments for a single student.  By selecting All classes before 

navigating to this screen the teacher will be able to see all assignments for a 
student at one time. Note that Standards grades cannot be entered through this 

screen.  You can view the number of entered grades but they cannot be entered or 
modified. 

 
To Enter Scores: 

 

1.  Select the class or group of classes from the top of the screen. 
2.  Select the Assignment for which you want to enter grades. 

3.  Enter the scores into the Score column either by typing the  
  grade directly into the grade cell or by using the Score  

  inspector (see section on Score Inspector below).   
 

 
 

 

Standards – Assignment Scores 

 

Standards Assignment Score entry, as mentioned above, can only be completed from 

the Grading > Assignment screen. 
 

• Grading > Assignment – Teachers can enter Standard Scores for a single 
assignment for multiple students.  If the same assignment has been linked to 

multiple classes that teacher can enter grades for ALL students at one time rather 
than having to switch from one class to another. 

 
To Enter Scores: 

 

1.  Select the class or group of classes from the top of the screen. 
2.  Select the Assignment for which you want to enter grades. 

3.  The Standard Grade columns appear to the right of the   
 Assignment Score. 

 



POWERTEACHER PRO USER GUIDE          
 

PREPARED BY:                                                      116         

4.  Select the Standard for which you want to enter grades. 
5.  Enter the scores either by typing the grade directly into the   

grade cell or by using the Score inspector (see section on  
Score Inspector below).   

 

                      
 

     

Exporting / Importing Scores 

 

There are times when you may need to score assignments outside of PowerSchool or 
Import scores from another application.  The Export / Import function within 

PowerTeacher Pro will allow you to do this.  For this function to work the assignment 
must first be setup in PowerTeacher Pro.  

 
If exporting scorers from another program you would want to make sure that the import 

template is setup using the same format as a file exported from Power Teacher Pro.  The 
most common import file types are .csv and .txt.  (Exports from PowerTeacher Pro will 

be in .csv format.) 

 
To Import scores for an existing PTP Assignment: 

 
1. Go to Grading >Assignment List.   

 
 

 
 

 
2. Click the name of the assignment you wish to export. 
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3. In the upper-right corner of the assignment page, click the Gear icon.   
 

 
 

4. Select Export Scores Template.  If there are any existing  
assignment scores, choose whether, or not to include the scores  

in the exported file by clicking Yes or No in the Export Scores  
Template window.  

 

 
 

 
 

 
 

5. Open the exported file.   
 

The top of the spreadsheet includes the teacher's name,  
class, assignment name, due date, points possible,  

extra points, and score type. Below the assignment  
details are three columns — Student Number,  

Student Name, and Score.  
 

 

 
 

 
 

6. Enter the students' scores in the Score column 
    and save the spreadsheet as a .csv file. 

 
 

 
 

 
 

 
 

 

 
7. In PowerTeacher Pro, Go to Grading > Assignment List > Select the Assignment to         

    which you wish to import scores and click the Gear icon.  (Steps 1-3 above) 
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8. Select Import Scores.    

 
 

 
 

 
 

 

 
9. In the Import Scores window, click Browse Files.  

  
10. Select the spreadsheet file you wish to import. 

 
11. In the Format menu, use the default selection 

      of PowerTeacher Score Template. 
 

12. Check Validate Student Names to verify that  
      the student names in the import file match the  

      names of the students enrolled in the class. 
  

13. Click Next Review and correct any import errors.  
 

 

 
14. To import and save the scores in PowerTeacher  

      Pro, click Import 
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Entering Comments 

 

Whether entering comments for an Assignment or a Final Grade, you will use the Score 

Inspector to complete this task. 
 

Finial Grade Comments 
 

From any page that displays the Final Course Grade, 
click into the Final Grade cell for the selected student. 

This will open the Score Inspector. 
 

 
 

 

                           
     Comment Window - Click the Dialogue Bubble to  

     open the main Comment Window.  Use this area to  
     enter comments manually or through the   

     School/District generated Comment Bank. 
 

 
     Comment Quick Entry - use this box to manually  

     enter a narrative comment for any student 
 

 
 

 
 

 

 
 

Comment Window Entry 
 

 
A/B – Use the up/down arrows to move  

  forward or back from one student to  
  another. 

C/D – Use the left/right arrows to move from 
   one column to another.  Useful when  

   adding Assignment Comments. 
E -      Main entry area for comments. 
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        F – Use the Filter to search for a  

              specific comment/group of  
              comments. 

        G – Click the star to mark a   
              comment as a favorite. 

        H – Click the + sign to add a   
              comment to the comment  

              window. 

        I -  Set the default for spacing to  
              Line Break or Spaces. 

 
 

When in Comment Bank mode teachers can use a combination of Comment Bank and 
manual Comment entry. 

 
Comment Quick Entry –  

 
Use this box, at the bottom of the score inspector, to manually enter a narrative 

comment for any student.  
 

 

 
 

 

 
 

 
 

 
 

 
 

 
Once comments have been entered a comment bubble will appear  

in the score cell indicating that a comment has been entered.   
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Score Inspector 

 

Any time you click on a grade cell, whether it be an Assignment Grade, Standard Grade 
or Final Grade, PTP will automatically open the Score Inspector on the right side of the 

screen.  The numeric values displayed in the keypad portion will appear based on the 
type of grade scale, the grade options available within that scale and the assignment 

setup.   
 

The Score Inspector also offers two options for entering comments.  The quick entry 
block at the bottom of the Score Inspector can be used to enter a Teacher created 

narrative comment or through the Comment Link in the upper right corner.  This link 
provides access to both a manual entry screen as well as any School/District created 

Comment banks. 
 

 
 

 
The way in which the Score Inspector key pad appears, is determined by the type of 

grades being entered, the grade scale associated to the Course/Standard and the setup 

Assignment setup (Score Type, Possible Points) 
 

 
Traditional Grades – Assignments 

 
The Key Pad will appear based on: 

 
• The Grade Scale associated to the selected Class. 

• The Score Type/Possible Points as defined in the Assignment Setup 
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Standards Grades 
 

• The Grade Scale associated to the selected Standard 

        

Score Inspector Layout  

 

Individual Assignment/Standard Scores 
 

1. Click the X to close the Score Inspector.  

2. Move up/down Student List – Use the arrows to move 
    up or down the list of students. 

3. Move Across – Use the arrows to move across the row. 
4. Key Pad Entry – Enter the score directly in the key pad 

    entry box. Whatever is entered will be used to fill in the  
selected Grade field. 

5. Key Pad – Use the keys on the key pad to manually 
Enter a score in a grade cell. 

6. Codes – Click to open a window that allows for the 
selection of “Special Codes”.  These are codes that 

have been created at the District level that can be  
used in addition to the regular grade scale items.  If 

the code has been associated with one of the  
Assignment Indicators (see below) then the symbol, 

for that indicator, will appear along with the code. 

 
For example:   

 
 

 
7. Fill Scores down – Once you have entered a 

score in a grade cell, click to fill all blank cells below 
the manually entered grade. 
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8. Fill Score across - Once you have entered a score in a  
grade cell, click to fill all blank cells to the right of the  

manually entered grade. 
9. Assignment Indicators – These are additional flags That can be used with 

assignment scores.  Missing, Late, Incomplete and Absent can be assigned 
along with an actual assignment score.  Collected and Exempt would be used in 

place of an actual score. Note:  these codes are visible in the public portals 
10. Comment Window - Click to open the Comment Window.  Use this area to enter   

  comments manually or through a School, generated Comment Bank. 

 
A/B – Use the up/down arrows to move  

  forward or back from one student to  
  another. 

C/D – Use the left/right arrows to move from 
   one column to another.  Useful when  

   adding Assignment Comments. 
E -      Main entry area for comments. 

 
 

 
 

 
 

 

        F – Use the Filter to search for a  
              specific comment/group of  

              comments. 
        G – Click the star to mark a   

              comment as a favorite. 
        H – Click the + sign to add a   

              comment to the comment  
              window. 

        I -  Set the default for spacing to  
              Line Break or Spaces. 

 
When in Comment Bank mode teachers can use a combination of Comment Bank and 

manual Comment entry. 
 

11. Comment Quick Entry - use this box to manually enter a narrative comment for 

any student.  
 

Once comments have been entered a comment bubble will appear 
in the score cell indicating that a comment has been entered.   
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Citizenship Scores 
 

If enabled from District Office, Teachers can enter Citizenship  
grades for by going to Grading > Traditional.  When the  

Teacher clicks into the grade cell for Citizenship, the  
appropriate Score Inspector will appear.  Only those grades 

defined for Citizenship Will be available for entry.  Note that 
comments cannot be entered with Citizenship grades. 

 

 

 
 
 

 
 

 

 
Overwriting – Final Traditional or Standard Scores 

 
 

When attempting to manually overwrite a Final Grade, 
be it a Traditional Grade and/or Standard Grade, the  

Score Inspector will look slightly different.  The grade entry 
area will contain some additional features. 

 
1. Letter Grade – Use to manually overwrite the  

final Letter Grade for a section. 
2. Percentage Grade – Use to manually overwrite the 

final Percentage grade for a section.  Note that  
updating the Letter grade will not automatically 

update the corresponding percentage grade. 

3. Clear Letter Grade– Use to clear any values 
entered in the Letter Grade field. 

4. Edit Percentage – Click the pencil icon to change 
to a 10-point key pad. 

5. Revert – Use to revert (undo) a manually overwritten score back to the 
calculated score. 

 
 

 
 


